
What is First Aid?

First Aid gives you the power to take control of your PC. 

First Aid can

n Automatically diagnose and fix thousands of PC problems.

n Prevent problems that may arise in the future.

n Get your PC running again when a serious problem prevents it from starting properly.

n Back up your data and save system settings.

n Provide instruction for common computer-related tasks.

n Teach you more about computers in general.

If your computer is connected to the Internet, First Aid can also

n Automatically update its knowledge base so that it actually gets smarter over time.

n Use Oil Change technology to search the Internet for updates and patches to First Aid.

n Send preaddressed email to, and connect to the web sites of, thousands of hardware and software vendors nationwide.

{button ,AL(`Getting started;How First Aid    works',0,`',`')}    See Also



How First Aid works

Although First Aid provides features like problem prevention, PC maintenance and general education, the heart of First Aid is its 
ability to diagnose and solve your computer problems. This is accomplished in two stages:

1 Check-Up
First Aid's problem-solving and solution system begins with Check-Up. Check-Up is run from the First Aid Desktop. When 
Check-Up finds a problem, it gives you    information on that problem and offers to fix it automatically. If the problem cannot be 
fixed automatically, Check-Up gives you the information you need to fix it yourself. 

2 Advisor
If Check-Up does not detect your problem, First Aid automatically takes you to the Advisor, an intelligent data base of 
information about computer problems. Advisor uses a series of questions to identify your problem, then either fixes it 
automatically, plays a video that demonstrates how to fix it, or outlines the steps required to fix it yourself. 

{button ,AL(`Getting around in First Aid;Getting started;What is First Aid?',0,`',`')}    See Also



Getting started

How do you want to use First Aid?

{button ,JI(`FIRSTAID.HLP>second',`fa98_Run_a_general_check_up')} Your computer seems to be working fine, but you 
want to put it through a general check-up anyway to make sure everything's running smoothly.

{button ,JI(`FIRSTAID.HLP>second',`fa98_Run_a_general_check_up')} You're having a problem with your computer but 
you don't know what's causing it. 

{button ,JI(`FIRSTAID.HLP>second',`fa98_Troubleshoot_a_specific_problem')} You're having a problem with a specific part of 
your computer. 

{button ,AL(`Getting around in First Aid;How First Aid    works;What is First Aid?',0,`',`')}    See Also



Getting around in First Aid

There are two ways to get around First Aid:

n Buttons

Like most traditional software programs, First Aid uses buttons such as Yes, No, Back, Cancel and Finished that enable you to 
move through the application. First Aid's complete array of features can be accessed through the use of these buttons.

n The navigation bar

The navigation bar is one of the things that sets First Aid apart from other Windows applications. The navigation bar allows 
you to use First Aid much as you would a Web browser. You can go from the main program to a computer vendor's site on the 
World Wide Web and back again without ever having to load another program. 

{button ,JI(`FIRSTAID.HLP',`secondary_The_navigation_bar')} Click here for help on how to use the navigation bar.

{button ,AL(`Getting started;How First Aid    works;What is First Aid?',0,`',`')}    See Also



Run a general Check-Up

By default, the general Check-Up checks every component on your computer system for problems. All of the tests that Check-Up 
performs can be performed without interaction from you. Additional tests, which are either more time-consuming or require 
interaction from you, are available for some components. If you want to perform all tests for a component, you can either perform 
a component-specific Check-Up or change the general Check-Up settings for that component. You can view and customize 
exactly what Check-Up checks in the Settings dialog box. 

To manually run a general check-up

n From the First Aid Desktop, click the large button labeled Check-Up.

You can click Cancel at any time to interrupt Check-Up. When Check-Up is finished, the results are displayed in the Check-Up 
Report. 

{button ,KL(`Scheduling First Aid events',0,`',`')} Click here for information on scheduling Check-Up.

{button ,AL(`Check an application;Troubleshoot a specific problem;Customize Check-Up',0,`',`')}    See Also



Troubleshoot a specific problem

When you suspect that a specific component is causing problems for your PC, you can check it individually. (We do recommend 
that you start by running a general Check-Up because problems are sometimes intertwined and fixing one problem can clear up 
related problems.) The general Check-Up checks all components for the most common problems in the most efficient manner, 
without requiring your interaction. Checking specific hardware components runs all possible checks for that component. Some of 
these checks may be time-consuming and may require interaction from you.

The First Aid Desktop is designed to allow you to check separate parts of your computer system quickly and easily. Click a 
component to display the list of actions that you can perform on that component. When you click the Generic Software box, First 
Aid displays the Fix Applications screen where you can perform more detailed checks for applications with enhanced support in 
the First Aid knowledge base.

If the Check-Up process doesn’t resolve your problem, you can use the Knowledge Base in Ask Advisor for additional 
troubleshooting assistance.

{button ,AL(`troubleshoot',0,`',`')}    See Also



View problems

When you run Check-Up (either a general or component-specific Check-Up) any problems found are listed in the Check-Up 
Report. 

Problems are divided into three groups:

n Critical Problems

n Potential Problems

n Tips & Performance Issues

To view any of these groups in detail, click View. View takes you to category-specific problem pages. 

The Check-Up Report keeps track of your list of problems, but only until you run Check-Up again or exit First Aid. For a more 
permanent record, use the Problem Log.

{button ,JI(`FIRSTAID.HLP',`screens_The_Check_Up_Report')} Click here for more help on the Check-Up Report.

The Problem Log

The Problems Log is a permanent list of your fixed problems. Unlike the Check-Up Report, the Problem Log is never erased. The 
only way to remove an entry in the list is to click Remove in the Problem Log page. Please note, however, that the Problem Log 
does not record unresolved problems. If you exit First Aid, the only way to view an unresolved problem is to run Check-Up again.

{button ,JI(`FIRSTAID.HLP',`screens_Problem_Log')} Click here for more help on the Problem Log.

{button ,AL(`Automatically fix a problem;Ignore problems;Manually fix a problem;Save problems',0,`',`')}    See Also



Ignore problems

If you find that First Aid is reporting a problems that you don’t want it to display in the future, you can instruct First Aid to ignore 
the particular problem or group of problems. Once a problem is ignored, Check-Up will not check for that problem. Ignored 
problems can be viewed and reversed (unignored) in the Ignored Problems page.

Click the button to see how to 

{button ,JI(`FIRSTAID.HLP',`secondary_Ignore_a_problem')} Ignore a problem

{button ,JI(`FIRSTAID.HLP',`secondary_Reverse_an_ignored_problem')} Reverse an ignored problem

{button ,AL(`Automatically fix a problem;Manually fix a problem;Save problems;View problems',0,`',`')}    See Also



Save problems

Every time you fix a problem in First Aid, that fix is automatically recorded in the Problem Log. The Problem Log is a permanent 
record of all fixed problems. Exiting First Aid or shutting down your computer will not erase the Problem Log. The only way to 
remove an entry from the Problem Log is to use the Remove button on the Problem Log page.

There is no way to save problems that have been reported by Check-Up but have not been fixed. If you exit First Aid and want to 
view an unresolved problem, just run Check-Up again. If the problem still exists, it will appear in the Check-Up Report.

{button ,AL(`Automatically fix a problem;Ignore problems;Manually fix a problem;View problems',0,`',`')}    See Also



Print a list of problems

Click a button for help on the following items:

{button ,JI(`Firstaid.HLP',`secondary_Print_a_list_of_all_problems_found')}    Print a list of all problems found.

{button ,JI(`Firstaid.HLP',`secondary_Print_a_list_of_all_problems_fixed')}    Print a list of all problems fixed.



Automatically fix a problem

Whenever you see the AutoFix button, it's Fist Aid's way of saying "Let me try to fix this for you automatically." Generally 
speaking, AutoFix will try to fix whatever is selected, whether it be a group of problems, an individual problem, or a particular 
solution for a single problem. In all cases, AutoFix addresses only those items you select.

AutoFix does not fix every problem. Sometimes the problem is outside of First Aid's direct control and must be addressed 
manually. 

{button ,JI(`FIRSTAID.HLP',`fa98_Manually_fix_a_problem')} Click here to find out more about Manual Fix.

{button ,AL(`Ignore problems;View problems',0,`',`')}    See Also



Manually fix a problem

Clicking Manual Fix has two possible results

1 First Aid brings up a series of dialog boxes that guide you through the fix.

2 First Aid cannot provide automated assistance, but it can offer step-by-step instructions on how to fix the problem. This is 
frequently the case with fixes that involve changes to your hardware.

Sometimes a problem can be fixed using both AutoFix and Manual Fix. In these cases you have the choice of clicking AutoFix 
and letting First Aid complete the task for you, or clicking Manual Fix and playing a more direct role in fixing the problem. 

{button ,JI(`FIRSTAID.HLP',`fa98_Automatically_fix_a_problem')} Click here for more information about AutoFix.

{button ,AL(`Ignore problems;View problems',0,`',`')}    See Also



Use the Advisor

If Check-Up does not detect your problem, you are automatically led to First Aid's second problem-solving stage—the Advisor. 
The Advisor is a specialized data base designed to diagnose and solve your problem by asking you a series of questions. 

Once Advisor diagnoses your problem, it searches the First Aid knowledge base and presents a solution. In some cases, an 
AutoFix button will appear, indicating that First Aid can fix the problem automatically. A Show Me button indicates that there is a 
video to help you with your problem. In other cases, you can click Manual Fix or follow step-by-step instructions and fix the 
problem yourself.

{button ,AL(`Run a general check up;Troubleshoot a specific problem;Use the ActiveHelp Center',0,`',`')}    See Also



Run Disk Defragmenter

Over the course of time, files get scattered, or fragmented, on a hard disk. Fragmentation can greatly impact your computer's 
performance. Disk Defragmenter is a Windows utility that corrects this problem. Because file fragmentation is an ever-present 
problem, defragmentation should be treated as periodic maintenance, not a one-time-only task.

To run Disk Defragmenter

1 From the Tools menu, click Defragment Hard Drive.

2 Windows Disk Defragmenter will guide you through the rest. For more information about an item in the Disk Defragmenter 
dialog box, right-click the item and click "What's this?"

Note

If McAfee Nuts & Bolts software is installed, First Aid uses DiskTune—the more advanced defragmenter program in Nuts & 
Bolts—to optimize your hard drive. Please refer to the documentation that came with Nuts & Bolts for more information on 
DiskTune.

{button ,AL(`Run ScanDisk;Run VirusScan',0,`',`')}    See Also



Run ScanDisk

Scan Disk is a Windows utility that checks for and repairs errors on your hard disk and floppy disks. ScanDisk is run by default 
as part of Check-Up, but it can also be run by itself from the Tools menu. For more information about an item on the screen, 
right-click the item and click "What's this?"

ScanDisk has two modes:

{button ,JI(`FIRSTAID.HLP>second',`secondary_ScanDisk_Standard_scan')}    Standard scan

{button ,JI(`FIRSTAID.HLP>second',`secondary_ScanDisk_Thorough_scan')}    Thorough scan

When you first run First Aid, ScanDisk's Standard scan is included by default as part of Check-Up. To run a thorough scan, check 
the Thorough Scan option in the ScanDisk dialog box. 

{button ,JI(`FIRSTAID.HLP>main',`screens_Check_Up_Settings')} Click here for help on customizing Check-Up.

{button ,JI(`FIRSTAID.HLP>main',`secondary_Run_ScanDisk_by_itself')} Click here for help on running ScanDisk by itself. 

Note

If McAfee Nuts & Bolts software is installed, First Aid uses Disk Minder—the more advanced disk repair utility in Nuts & Bolts
—to diagnose and fix hard drive problems. Please refer to the documentation that came with Nuts & Bolts for more information 
on Disk Minder.

{button ,AL(`Run Disk Defragmenter;Run VirusScan',0,`',`')}    See Also



Clean up unnecessary files

As the hard drive in your PC runs out of free disk space, your PC runs less efficiently. If disk space becomes extremely low, you 
won’t be able to save your work and your software may even crash. 

The QuickClean wizard frees disk space by getting rid of unnecessary files. It deletes Internet junk files that accumulate as you 
cruise the Internet, empties the Recycle Bin, and removes references to applications that are no longer installed on your 
computer. The default settings for QuickClean are designed to be so safe that you can either run it manually or schedule it to run 
unattended.

Note

Deleted files are not backed up. You cannot restore files deleted by QuickClean.

To run QuickClean manually

§ From the Tools menu, click Clean Up Unnecessary Files. As you run the QuickClean wizard, First Aid displays an arrow to 
indicate its progress in the box on the left-side of the dialog box. QuickClean guides you through the following steps:

§ Step 1: Select cleaners. 

§ Step 2: Analyze system. 

§ Step 3: View items to be removed. 

§ Step 4: Delete unneeded items. 

§ Step 5: Review summary information. 

{button ,KL(`Scheduling First Aid events',0,`',`')} Click here for information on scheduling Quick Clean.



Select cleaners

1 Select the cleaners you want to run. To see what a cleaner does, click the name of the cleaner and information about it 
appears in the Cleaner Description box. 

2 Click Next. 



Analyze system

§ The wizard analyzes your computer to determine what files and Registry entries can be removed safely. To cancel the 
analysis, click Stop.



View items to be removed

1 QuickClean displays a summary of how many files and Windows Registry entries it can remove. If you want to see exactly 
what will be removed, click Details. 

2 Do one of the following: 

§ Click Clean to begin deleting the files.

§ Click Close if you've changed your mind.



Delete unneeded items

§ QuickClean deletes the files. To stop deleting files, click Stop. (Unless you are deleting a lot of files, this step happens quickly.)



Review summary information

1 QuickClean displays a summary with the number of files deleted and disk space freed by each cleaner. Click Details to see a 
complete report. 

2 Click Close to return to the First Aid Desktop. 



Trim Applications

Trim Applications lets you increase your hard disk space by "trimming" little-used features from applications. You can archive 
(compress and store) or delete unnecessary components only from applications that have enhanced support. You can tell if an 
application has enhanced support by checking for a small cross on the lower left corner of the application icon in the Fix 
Applications page. 

Click a button for help on the following

{button ,JI(`FIRSTAID.HLP',`Trim_an_application')} Trim an application

{button ,JI(`FIRSTAID.HLP',`HELP_KEY_RESTORE_FILES')} Restore all or part of a trimmed application

{button ,JI(`FIRSTAID.HLP',`Remove_a_trimmed_application')} Remove all or part of a trimmed application

Warning

If you plan to uninstall First Aid, you must restore all trimmed applications or risk a permanent data loss. 



Run VirusScan

The VirusScan in First Aid uses the same technology as McAfee VirusScan. VirusScan's powerful antivirus technology, scans for 
viruses in your system files, applications, and data files and can detect 100% of all known viruses. VirusScan is run by default as 
part of Computer Check-Up, but it can also be run by itself from the Tools menu.

{button ,JI(`FIRSTAID.HLP',`screens_Check_Up_Settings')} Click here for help on customizing Check-Up.

To run VirusScan by itself

1 Click Tools.

2 Click Scan For Viruses.

3 VirusScan guides you through the rest. For more information, open Help in VirusScan.

Note

VirusScan in First Aid detects viruses but does not fix them. For full-featured virus detection and eradication, you must use a full 
version of McAfee VirusScan. Please call 888-712-1477 to purchase a full version of McAfee VirusScan. A free evaluation copy 
of VirusScan may be downloaded from the following site: http://www.mcafee.com/download/eval.asp.

{button ,AL(`Emergency Care;Run Disk Defragmenter;Run ScanDisk',0,`',`')}    See Also



Run Year 2000 Checker

The year 2000 (Y2K) bug is a term used to describe the inability of computer hardware and software to be able to deal dates 
past the year 1999. In the past, software code was written to store the year using its last two digits. For example, 1999 would be 
stored as 99. Unfortunately, under this system the year 2000 would be represented by 00, which is smaller than 99.

The Y2K Checker checks your PC to see if its BIOS can handle the year change to 2000. If your PC hardware is not Y2K 
compliant you may find that files created after 1999 will not have the correct date and cannot be sorted correctly. Also, any 
program that uses the file dates to make calculations will function incorrectly.

If your PC fails the Y2K tests, the Y2K Repair Facility (Y2KFIXER.COM) is installed on your hard drive. A line is added in the 
AUTOEXEC.BAT file that causes the program to run each time you start your PC. This ensures year 2000 hardware compliance 
whether the system is turned on or off during the transition to the next millenium.

Warning

The Y2KFIXER.COM program does NOT fix software packages, such as spreadsheets and databases, which represent dates 
with only a two-digit year. Contact the software manufacturer to determine if your version is year 2000 compliant.

To start the Y2K Compliance Checker:

§ From the Tools menu, click Check For Year 2000 Compliance. The Y2K Checker wizard guides you through the steps. (Click 
the Help button in the Y2K Checker for more information.)

{button ,EF(`y2k.hlp',`',1,)} Click here to open Y2K Checker Help.



Use CPR

CPR is part of the First Aid Guardian family of PC monitors. It revives unresponsive or "frozen" programs that no longer react to 
mouse clicks or keyboard input.

Click the button for help on

{button ,JI(`FIRSTAID.HLP>second',`secondary_Set_CPR_properties')} Setting CPR properties.

{button ,JI(`FIRSTAID.HLP>second',`secondary_Test_and_use_CPR')} Testing and using CPR.

{button ,JI(`FIRSTAID.HLP>second',`fa98_Reactivate_a_frozen_application_with_CPR')} Reactivating a frozen or unresponsive 
application.



Use Crash Protector

Crash Protector is part of the First Aid Guardian family of PC monitors. Crash Protector intercepts general protection faults and 
other system crashes, thereby enabling you to save your work. It also provides crash statistics and lets you "crash-test" First Aid 
on your PC.

Click the button for help on

{button ,JI(`FIRSTAID.HLP>second',`secondary_Test_Crash_Protector')} "Crash-testing" Crash Protector.

{button ,JI(`FIRSTAID.HLP>second',`secondary_Set_Crash_Protector_Properties')} Setting Crash Protector properties.



Use Disk Space Monitor

Disk Space Monitor is part of the First Aid Guardian family of PC monitors. Disk Space Monitor monitors how much space is 
available on your hard disk and warns you if you are running low. Low available disk space can cause some programs to behave 
erratically or even crash. 

Click the button for help on

{button ,JI(`FIRSTAID.HLP>second',`secondary_respond_to_Disk_Space_Monitor_warning')} Responding to a Disk Space 
Monitor warning.

{button ,JI(`FIRSTAID.HLP>second',`secondary_Set_Disk_Space_Monitor_Properties')} Setting Disk Space Monitor properties.



Use Memory Monitor

Memory Monitor is part of the First Aid Guardian family of PC monitors. Memory Monitor monitors your computer's use of 
available memory (RAM) for GDI, User, and system resources, and warns you if those resources are running low.

{button ,JI(`FIRSTAID.HLP>second',`secondary_Set_Memory_Monitor_properties')} Click here for help on setting Memory 
Monitor properties.



Use Quick Clean

Quick Clean removes unneeded files that accumulate as you use your computer:

§ Internet cache files—When you surf the Internet, copies of the files that you view are copied to your hard disk to speed up 
browser performance. These files stay on your computer until they are eventually deleted by your browser.

§ Recycle Bin files—When you delete files they are moved to the Recycle Bin in case you change your mind. Depending on 
your Recycle Bin settings, these files may remain on your hard disk for a long time.

§ Temporary files—When you work with documents or install programs, temporary files are often created to improve system 
performance. The files are supposed to be deleted after they are no longer needed. Unfortunately, sloppy programming and 
program crashes can leave behind these temporary files.

§ Shortcut files—When programs are installed they often create shortcuts, which allow you to open programs from a location 
different from where the programs are stored on your hard disk. If you remove a program by deleting it (rather than using 
Add/Remove Programs or an uninstall program) or if the program uninstaller doesn’t remove the shortcut, you are left with 
shortcuts that don’t do anything but take up room on your hard disk.

Quick Clean is triggered when:

§ Disk Space Monitor detects that you are running low on disk space.

§ The number of hours of computer usages is reached, as indicated in the Quick Clean event in What’s Scheduled. 

{button ,JI(`firstaid.HLP>second',`Set_Quick_Clean_properties')} Click here for help on selecting Quick Clean properties.

{button ,JI(`FIRSTAID.HLP>second',`secondary_Set_Disk_Space_Monitor_Properties')} Click here for setting Disk Space 
Monitor properties.

{button ,JI(`firstaid.HLP',`Scheduling_First_Aid_events')} Click here for scheduling First Aid events.



Use S.M.A.R.T. Disk Monitor

S.M.A.R.T. Disk Monitor is part of the First Aid Guardian family of PC monitors. S.M.A.R.T. Disk Monitor checks the status of 
S.M.A.R.T. sensors built into certain types of hard drives. If your hard disk is showing significant signs of wear, S.M.A.R.T. Disk 
Monitor alerts you.

{button ,JI(`FIRSTAID.HLP>second',`secondary_Set_Early_Warning_properties')} Click here for help on selecting S.M.A.R.T. 
Disk Monitor properties.



Create an Emergency Disk

1 Put a blank, formatted high-density floppy disk in your floppy disk drive.

2 From the Tools menu, click Emergency Disk. The Create Emergency Startup Disk wizard appears.

3 Select the disk drive to which you want to save the emergency start-up disk information (this usually the floppy drive A:)

4 Click Next and follow the instructions on the screen.

5 Click Finish when prompted.

6 Take the disk out of the floppy disk drive, label it, and write-protect the disk by sliding the write-protect tab to the open position.

{button ,KL(`emergency disk',0,`',`')}    See Also



Test the Emergency Disk

1 Turn off your computer.

2 Put the emergency startup disk in the floppy disk drive.

3 Turn on your computer.

4 If your computer can start from the Emergency Disk, ScanDisk will begin running.

5 Take the disk out of the drive and store it in a safe location.

6 Restart your computer.

{button ,KL(`emergency disk',0,`',`')}    See Also



Create a backup

Use Backup to backup files on your hard disk to a floppy disk, tape drive or network drive. If the files on your hard disk are ever 
damaged or lost, you can restore the files using Backup.

1 From the Tools menu, click Backup Important Files. The Microsoft Backup window appears.

If you do not have Microsoft Backup Installed, First Aid will ask you if you want to install it. Click Yes and follow the instructions 
to install Microsoft Backup (you will need your Windows CD ROM to install the necessary files). 

2 After selecting each file or folder that you want to back up, click Next Step.

3 Select the destination of your storage media. This can be a floppy disk, a tape drive, or even a network drive.

4 Click Start.

Tip

For more help on using Backup, click the Help menu in the Backup window. For more information about an item on the screen, 
right-click the item and click "What's this?"

{button ,AL(`backup',0,`',`')}    See Also 



Use Event Monitor

Event Monitor is like a specialized backup program that allows you to record and restore important changes to your PC. Event 
Monitor tracks changes made when you:

§ Install new software.

§ Change settings in the following Control Panel applets: Display, Keyboard, Modems, Mouse, Multimedia, Printers, Sounds, 
and System. 

§ Change Internet or network settings.

§ Edit documents associated with monitored applications.

§ Perform a First Aid fix.

In order to use Universal Undo, you must keep Event Monitor active while you use your computer. (When you install First Aid, 
Event Monitor is set up to run automatically.)

Whenever you make a change to one of the monitored areas, a monitor icon  appears in the Windows taskbar. A blinking 
monitor icon indicates that the change under progress is being monitored and recorded by First Aid.

To verify that Event Monitor is active

1      Right-click   the blue cross  in the lower right corner of your screen. A shortcut menu appears. 

2 Click First Aid Properties.

3 In the First Aid Guardian tab, make sure that Event Monitor is selected.

{button ,JI(`FIRSTAID.HLP>second',`secondary_Set_Application_Monitor_properties')} Click here for help on setting Event 
Monitor properties.

{button ,KL(`restoring',0,`',`')} See Also



Restore a backup

1 Insert the floppy disk or other storage media containing the backup files in the proper drive.

2 From the Tools menu, click Restore Backup Archive.

3 From the Microsoft Backup window, click the Restore tab.

4 Select the drive where the backup files are located.

5 Click the Backup set that you wish to restore.

Tip

For more help on using Backup, click the Help menu in the Backup window. For more information about an item on the screen, 
right-click the item and click "What's this?"

{button ,AL(`backup',0,`',`')}    See Also 



Restore using Universal Undo

Universal Undo lets you restore your PC to a previous state by reversing changes made to your PC when you:

§ Install new software.

§ Change a Control Panel setting using the Display, Keyboard, Modems, Mouse, Multimedia, Printers, Sounds, or System 
applets.

§ Change a document associated with a monitored application.

§ Change an Internet or network setting.

§ Perform a fix in First Aid

Event Monitor—a part of First Aid Guardian—keeps track of what files are added, updated, and removed, and what changes 
made to the Windows Registry. (You can undo only those changes that were made while Event Monitor was running.)

To use Universal Undo

1 Click Universal Undo on the First Aid Desktop. 

2 Click the type of change that you want to undo. The wizard guides you through the undo process.

{button ,AL(`undo',0,`',`')} See Also 



Restore all or part of a trimmed application

1 On the Fix Applications page, right-click a trimmed application. Trimmed applications are marked by a small "T" in the lower-
left corner of the applications icon. A shortcut menu appears.

2 Click Restore. First Aid displays information about the trimmed application, including the features that were trimmed.

3 Select the features you want to restore and click Restore.

4 Click Proceed. First Aid restores the selected components.

5 Select another feature to restore, or click Close to return to Fix Applications.

Restore dialog box

{button ,PI(`FIRSTAID.HLP',`trimapp_confirm_restore')} Confirm each restore

{button ,PI(`FIRSTAID.HLP',`trimapp_generate_log')} Generate log file

Note

If you intend to remove First Aid from your computer, be sure to fully restore any trimmed applications that you may want to 
use in the future.

{button ,AL(`Remove a trimmed application;Trim an application',0,`',`')}    See Also



Catch a software crash with Crash Protector

Crash Protector automatically catches software crashes. All you have to do is make sure Crash Protector is turned on. It is 
turned on by default.
{button ,JI(`FIRSTAID.HLP>second',`secondary_Set_Crash_Protector_Properties')} Click here for help on setting Crash 
Protector properties.

{button ,KL(`Windows Guardian;Crash Protector',0,`',`')}    See Also



Reactivate a frozen application with CPR

When an application freezes, it no longer responds to input from your mouse and keyboard. CPR allows you to unfreeze a frozen 
application and save your data. 

There are two ways to reactivate a frozen application:

First method 

1      Right-click   the blue cross  in the lower right corner of your screen. A shortcut menu appears. 

2 Click Reactivate Application. The First Aid CPR dialog box appears

3 Select the frozen application from the list.

4 Click Reactivate.

Second method

1 Type Ctrl+Alt+Del (all three keys at once). 

2 The Close Program - First Aid CPR dialog box appears. Scroll down the list until you find the unresponsive application. Select 
the application.

3 Click Reactivate. 

Note

Clicking End Task will close the program without saving your data. Clicking Shut Down restarts your computer, causing you to 
lose all unsaved data on your PC. 

{button ,KL(`Windows Guardian;CPR;Emergency Care',0,`',`')}    See Also



Start my computer with the Emergency Disk

1 Turn off your computer.

2 Put the Emergency Disk in the floppy disk drive.

3 Turn on your computer.

4 The Emergency Disk starts running ScanDisk, which looks for and repairs many disk errors.

Note

You should make a new Emergency Disk every month or so to make sure that it is up-to-date.

{button ,KL(`emergency disk',0,`',`')}    See Also



Update First Aid

First Aid uses Oil Change technology to update itself over the Internet. You must have an Internet connection to use this feature. 
First Aid Guardian is set up to remind you to update First Aid.

To update First Aid

1 From anywhere in the program, click Update Now! on the menu bar. The Update page appears.

2 Click Update. If new updates are available, Oil Change will download and install them automatically.

Tip

Updates are being added on a continuous basis. To make sure your version of First Aid is as up-to-date as possible, use the 
Update feature every month or so. 

{button ,AL(`Undo an update;View update history',0,`',`')}    See Also



Customize Check-Up

To customize the general Check-Up

n Click Options on the menu bar, point to Settings, and click Check-Up.

n From the First Aid Desktop, right-click the large button labeled Check-Up. 

In both cases, the Settings dialog box appears with a complete breakdown of checks.

To customize Check-Up for a specific component

n From the First Aid Desktop, click a computer component. A menu appears. Click Settings.

The Settings dialog box appears. Only the checks pertaining to the selected component will appear.
{button ,JI(`FIRSTAID.HLP',`screens_Check_Up_Settings')} Click here for help on the Settings dialog box.

Note

First Aid maintains different settings for general Check-Up and component-specific Check-Ups. By default, general Check-Up 
is configured to perform the most detailed check possible without requiring assistance from the user (inserting an audio 
compact disc, for example), while the component-specific check is set by default to perform the most thorough check possible. 
Any of these settings can be changed at any time without affecting the other.



Customize First Aid

To customize First Aid's general settings

§ Click Options, point to Settings, and click First Aid. The First Aid Properties dialog box appears. 

{button ,JI(`FIRSTAID.HLP',`screens_First_Aid_Properties')} Click here for help on the First Aid Properties Dialog box

Other ways to customize First Aid 

{button ,JI(`FIRSTAID.HLP',`fa98_Customize_Check_Up')} Customize Check-Up

{button ,JI(`FIRSTAID.HLP',`secondary_Show_or_hide_Bubble_Help')} Show or hide Bubble Help



Customize First Aid Guardian

First Aid Guardian runs while you use your computer, monitoring your computer for conditions that can cause it to perform poorly 
or even fail. You can turn off or on specific monitors or change their settings. You can also turn off First Aid Guardian altogether.

To customize First Aid Guardian

1 Do one of the following: 

§ Right-click the blue cross icon  in the lower-right corner of your screen, then click First Aid Properties.

§ Click Options, point to Settings, and click First Aid.

2 In the Properties dialog box, iIf necessary, click the First Aid Guardian tab to select it.

3 Select the check box next to the First Aid Guardian monitor that you want to enable.

4 Click the monitor name to see the properties you can change for that monitor. 



Scheduling First Aid events

First Aid Guardian contains the What’s Scheduled feature, which lets you run events—actions that can be performed by First 
Aid. For your convenience, What’s Scheduled comes set up with prescheduled events:

§ Checkup—Runs a general Check-Up at specified intervals.

§ CPR—Turns on or off CPR.

§ Crash Protector—Turns on or off Crash Protector.

§ Disk Space Monitor—Turns on or off Disk Space Monitor.

§ Event Monitor—Turns on or off Event Monitor.

§ Memory Monitor—Turns on or off Memory Monitor.

§ Quick Clean— Runs a Quick Clean at specified intervals.

§ Register First Aid Reminder—Displays a message to remind you to register First Aid.

§ Register Oil Change Update Reminder—Displays a message to remind you to update First Aid.

§ S.M.A.R.T. Disk Monitor—Turns on or off S.M.A.R.T. Disk Monitor.

The two events that you may most want to customize are Check-Up and Quick Clean. You can schedule these tasks to run 
automatically while you are away from your computer, so that your workflow isn’t interrupted.

To view What’s Scheduled

1 Right click the  in the Windows taskbar.

2 Click What’s Scheduled.

{button ,EF(`cmgrdian.hlp',`',1,)} Click here to display First Aid Guardian Help. 



Learn about your computer

First Aid provides access to sources of information about your PC that let your troubleshoot problems and learn more about the 
PC. These reference tools are available from the both Ask Advisor and the Help Reference menu.

To access the reference tools:

§ Do one of the following

§ From the First Aid Desktop, click Ask Advisor. 

§ From the Help menu, point to Reference.

{button ,AL(`advisor',0,`',`')}    See Also



Knowledge Base

The Knowledge Base lets you explore a wide array of common computer-related questions frequently asked by people trying to 
troubleshoot PC problems. Just click the general category that most directly relates to your question. Continue clicking the 
appropriate topic title until you find the answer to your question. With your help, the First Aid narrows down the possible causes 
to your problem. 

To get to the Knowledge Base

§ If Check-Up does not detect your problem, you are automatically given the option of entering the Advisor Knowledge Base.

§ To access the Knowledge Base directly, click Ask Advisor on the First Aid Desktop, then click Knowledge Base.



Glossary

First Aid provides you with an extensive glossary of computer-related words and acronyms. If at any time you have trouble 
understanding a technical term, look it up in the Glossary. 

To access the Glossary

1 From the First Aid Desktop, click Ask Advisor. 

2 Click Glossary. 

3 Do one of the following:

§  To browse through the glossary, click Contents then scroll through the list. Click a topic name to view it.

§ To search the glossary, click Search then type a word to search for and click List Topics. Click the topic to view, then click 
Display.



Technical Support Yellow Pages

The Technical Support Yellow Pages (known outside the U.S. as the Tech Support Directory) is a comprehensive list of technical 
support contact information for computer companies nationwide. You can use the Technical Support Yellow Pages to locate a 
company's mailing address, email address, telephone number, and web site address. If you have an Internet connection, the 
Technical Support Yellow Pages can launch your web browser and connect you directly to a company's web site. 

To access the Technical Support Yellow Pages

1 From the First Aid Desktop, click Ask Advisor. 

2 Click Technical Support Yellow Pages. 

3 Do one of the following:

§  To browse through the Technical Support Yellow Pages, click Contents then scroll through the list. Click a topic name to 
view it.

§ To search the Technical Support Yellow Pages, click Search then type a word to search for and click List Topics. Click the 
topic to view, then click Display.



Videos

First Aid provides you with a library of instructional videos on a wide range of computer-related tasks, such as plugging your 
modem into a phone line and cleaning your mouse.

To access the Videos

1 Do one of the following:

§ From the Help menu, click First Aid Videos.

§ From the First Aid Desktop, click Ask Advisor, then click Videos.

2 Click the name of the video you want to view, then click Play. 

{button ,AL(`How Do I...?;Play a video',0,`',`')}    See Also



System Info

System Information starts Discover, a system analysis tool that displays a wealth of system information and lets you perform 
benchmark tests. You can use Discover to explore your PC hardware and software configurations, and analyze and configure 
your PC. 

Unlike other system information tools, Discover doesn't simply display information that it obtained from Windows. Discover 
actually tests and measures the hardware and software in your system.

To open Discover

1 From the First Aid Desktop, click Ask Advisor.

2 Click System Info. 

{button ,EF(`Discover.hlp',`',1,)} Click here to open Discover Help.



Windows Help

If you have questions about how to use Windows, Windows Help can provide the answers. 

To use Windows Help

· From anywhere in the program, click Help, point to Reference, and click Windows Help



Get Help while you work

Bubble Help

To find out what any button does on any First Aid screen, just position the mouse pointer over the button or graphic (without 
clicking).A help bubble will appear describing what the button or graphic does.

{button ,JI(`FIRSTAID.HLP>second',`fa98_Show_or_hide_Bubble_Help')} Click here for help on showing and hiding Bubble Help

To get Help for a specific page

n Go to the page you want help on. Click Help on the menu bar and click Help for this page.

To search for a help topic

n From anywhere in First Aid, click Help on the menu bar and click First Aid Help Topics.
Depending on which tab you select, you can search the Table of Contents, the Index, or use Find to search for occurrences of 
a keyword. There are many First Aid help topics that are not in the Table of Contents, so if you can't find what you're looking 
for in the Table of Contents, use the Index for a more thorough search.



First Aid Readme

What is Readme.doc?

Readme.doc is a simple document that contains important last-minute information that did not get in the First Aid User's Guide or 
Online Help. 

Where is Readme.doc?

Readme.doc is located on the directory in which you installed First Aid. If you accepted the default directory during installation, 
that directory is "C:\Program Files\Network Associates\First Aid", where "C:" is your hard drive. 

To view Readme.doc

There are two ways to view Readme.doc:

n Click Start on the taskbar, point to Programs, point to First Aid, and click Release Notes.

n In Windows Explorer, double-click Readme.doc.

n Open a text editor such as Notepad, WordPad, or any word processor, and open Readme.doc the same way you would open 
any document.



Show or hide Bubble Help

When you first run First Aid, you can position your mouse pointer over a button or clickable graphic and a help bubble will 
appear. 

To show or hide the Bubble Help

n Click Options on the menu bar and click Bubble Help.



Contact technical support

Refer to the quick start card that came with your software for our technical support policy.

You can find the telephone number and email address of Technical Support by clicking Contacting Technical Support on the Help 
Menu in First Aid. However, the best and most up-to-date source for information about First Aid can be reached from the McAfee 
support Web page at http://www.mcafee.com/support. 

Please keep in mind that technical support addresses only those problems specifically related to First Aid. If you are having a 
general computer problem that Check-Up and Advisor could not solve, use the Technical Support Yellow Pages to find contact 
information for the vendor of the hardware or software product your are having a problem with.



Register First Aid

You can register your copy of First Aid at any time. If you skip registration, First Aid Guardian is scheduled to display a 
registration reminder.

To register your Copy of First Aid

n Click Options on the menu bar and click Register First Aid 2000.

Try to take the time to registering your copy. If you register, you will be notified of product updates and any special offers in the 
future. 



Select the application that is not responding and click Reactivate. If you are not sure which application is not responding, try one 
after the other. Try to reactivate the application that contains unsaved work. If you click Close Application, the application will 
close down and any unsaved work will be lost.



Reactivates the application you have selected. Save any unsaved work, then close the application and restart your computer.



Closes the application you have selected. If the application contains any unsaved data, it is lost. 



The Properties option lets you customize First Aid settings for PC Profile, Check-Up, Notify, First Aid Guardian, Internet, and 
Personalize features.



Displays components of a snapshot taken by BackTrack.



Displays the files monitored by BackTrack. This collection of files is saved as a Snapshot any time a system file changes (for 
example, at system startup or shutdown). If you have other files that are critical to the way your computer is configured, you can 
add them to the list of monitored files.



Prevents the selected snapshot from being deleted, even if the number of snapshots exceeds the snapshot limit specified in 
BackTrack's configuration. A small padlock appears on the icons of protected snapshots. If the snapshot is protected, clicking 
Protect removes the protection. 



Deletes a selected snapshot.



Lets you add a file to the BackTrack snapshot, delete a file, or change the maximum number of snapshots saved by BackTrack. 



Restore lets you restore a specific file from a BackTrack snapshot to its previous location.



View Changes lets you see the contents of a selected file. If BackTrack indicated that a change was made to the file since the 
previous snapshot, the addition and/or deletion is marked in the file.



Closes the Snapshot Components dialog box and returns to the BackTrack window.



Removes the selected file from the snapshot monitored by BackTrack. If you remove this file from the snapshot, BackTrack no 
longer tracks changes to it.



Lets you add a file to the snapshot monitored by BackTrack.



Restores the files in the selected snapshot to their original locations. Restoring these files causes them to replace the existing 
files.



Lists the files in the selected snapshot. Files that have changed since the last snapshot are marked. To see what changed within 
a file, click View Changes.



Closes the BackTrack window.



Lists the snapshots saved by BackTrack, with the date and time the snapshot was taken. Click Details to see the list of files 
within a snapshot.



Lets you change the selected snapshot's description.



Saves any changes you made to the snapshot description.



Lets you locate a file and add it to BackTrack's snapshot list.



Configure SNMP (Small Network Management Protocol) agent.



Specify at what point you want Memory Manager to warn you that Free Memory resources are low.



Confirm that your computer has a CD-ROM drive installed.



Displays a scoreboard of applications fixed by Crash Protector and problem reports saved.



Confirm that your computer has a modem installed.



Lets you create a 32-bit application freeze and use CPR to reactivate the application so you can save your work before you close 
the application.



Indicates that your computer has no Internet connection.



Lets you create a 16-bit application crash to see how to handle it using Crash Protector.



Displays the list of actions taken by First Aid.



Causes First Aid to display a message when an application problem is encountered.



Makes available the AutoFix button in the Diagnosis dialog box.



Adds First Aid check capability to the shortcut menu when you right-click an application in Windows Explorer.



The First Aid Guardian monitors keep track of vital operations. Click a monitor to see what it does.



Lets you select the online service for First Aid to use during Check-Up or Online/Modem Specialist checks. Options include 
America Online (AOL), CompuServe (WinCIM), Prodigy, Other, or none. To use an online service, to dial out, First Aid must be 
able to locate the online service's application in the Applications list.



Tells First Aid to notify you about low disk space by flashing the First Aid Guardian icon in the taskbar.



Opens the Windows Internet Properties dialog box so you can specify how to connect to the Internet when an application needs 
Internet access. 



Lets you create a 16-bit application freeze and use CPR to reactivate the application so you can save your work before you close 
the application. 



Lets you set minimum free disk space on all your hard disks. If the free disk space goes below the amount you specify, Disk 
Space Monitor notifies you by flashing the First Aid Guardian icon or displaying a message.







Indicates how you want S.M.A.R.T. Disk Monitor to notify you if it detects a problem with SMART sensor technology.



Turns on sound effects in First Aid.



Indicates how you want to be notified if one of the memory resources goes below the amount in the Alert criteria list. 



Warns you if system memory goes below the percentage indicated. Click the up or down arrow to change the percentage. 
System memory is used for the basic Windows operating features.



Warns you if graphic display resources (GDI) fall below the percentage indicated. Click the up or down arrow to change the 
percentage. Free GDI memory is used by Windows to create the video displays. Adding icons, and possibly, program groups, 
can cause GDI memory to decrease.





Tells First Aid to identify the items on your computer's profile now. The profile consists of the items on the Profile tab.



Lets you select an SNMP agent name and enter an IP address for the SNMP manager.



Causes the First Aid icon in the taskbar to flash and rotate when one of the memory resources goes below the specified amount.



Sends the Problem Log in an email message to the recipient you designate. Click Configure and enter your e-mail ID and 
password, the e-mail application, and the recipient’s e-mail address.



Edit the Problem Log.



Tells First Aid to notify you about low disk space by displaying a message.







Indicates that you have a dial-up modem connection to the Internet.



Indicates that you have a direct connection to the Internet, for example, over a Local Area Network.



Warns you if graphic display resources drop below the percentage indicated. Click the up or down arrow to change the 
percentage. Free GDI memory is used by Windows to create the video displays. Adding icons, and possibly, program groups, 
can cause GDI memory to decrease.





Configures First Aid to load First Aid Guardian when you start Windows. The icon appears on the taskbar. 



Warns you if free memory goes below the percentage indicated. Click the up or down arrow to change the percentage. 



Lets you enter a different file name and location for the Problem Log.



Confirms that your PC is connected to a network.



Warns you if system memory goes below the percentage indicated. Click the up or down arrow to change the percentage.



Causes the First Aid icon in the taskbar to flash and rotate when one of the memory resources goes below the specified amount.







Lets you locate and specify a different sound card manufacturer and model.



Causes the First Aid icon in the taskbar to flash and rotate when an application problem is encountered.



Enter a password to let First Aid automatically start your e-mail application and send notification of problems.



Lets you create a 32-bit application crash to see how to handle it using Crash Protector.



Indicates an Internet connection other than the listed choices.



Indicates that you connect to the Internet through America Online or CompuServe.



Indicates the e-mail name.



Lists e-mail applications compatible with First Aid’s notification process.



Tells First Aid to detect the presence of a CD-ROM, sound card, and other items on the PC Profile each time First Aid starts.



When checked, First Aid notifies you when user memory goes below the indicated percentage.



Click the spin button to adjust the low user memory percentage. If user memory resources go below the level you specify, First 
Aid alerts you.



Click the spin button to adjust the low user memory percentage. If user memory resources go below the level you specify, First 
Aid alerts you.



Reactivates a locked-up application.



Lets you select a sound card model after you have selected a manufacturer.



Lets you select a sound card manufacturer from the list, then select the available models.



Tells First Aid to identify the sound card manufacturer and model automatically.



To include a check in Check-Up, select its check box. To remove a check, clear its check box. You may select or clear a whole 
category, a sub-category, or single check box. The settings will be saved when you click OK.



Restores the default setting. This predefined setting runs the most thorough check possible without requiring user interaction. 



Selects all of the items displayed for the most thorough check up configuration possible. 



The Applications list shows all the applications First Aid found on your computer. First Aid scans your hard disk for applications 
each time you click Fix Applications. If an installed application does not show up on this list, you can add it manually. If an 
application is enhanced supported (indicated by a small cross on its icon) you can trim its related files. Trimmed applications 
have a small yellow "T" attached to their icons. 



Scan causes the Applications Specialist to re-scan your system for applications. 



Checks the application you have selected in the applications list.



Opens the Trim Application dialog box which lists the files that can be trimmed from a selected application.



Displays a menu of actions you can take with a selected application and with the Applications list.



Restore Archives

This feature is no longer relevant.



Restore or remove application archives

This feature is no longer relevant. 



Select features to trim

If the application you selected is part of First Aid's knowledge base, you can select specific features to trim. If you try to check an 
uninstalled feature, First Aid displays an error. To select just one feature, click UnSelectAll, then select the feature. 



Trim to save space by removing unused parts of an application. 



Restore to replace trimmed parts. 



Features displays a list of those features that can be trimmed. 



Add lets you add an application to the Applications list. 



Remove lets you delete an application from the Applications list. 



Large icons lets you display large applications icons. 



Small icons lets you display small applications icons. 



List lets you display the Applications list in column format. 



Details lets you add the name of the application's executable file and trimmed or untrimmed status to the Applications list.



Marks the selected archive to be restored. When you click Restore, you have a chance to select the components you want 
restored.



Delete the archive selected in the list.



Remove all or part of a trimmed application

1 On the Fix Applications page, right-click a trimmed application. Trimmed applications are marked by a small "T" in the lower-
left corner of the application's icon. A shortcut menu appears.

2 Click Restore. First Aid displays information about the trimmed application, including the features that were trimmed.

3 Click the archive you want to delete and click Remove Archive.

The archive is deleted from your hard disk.

Note

To take advantage of your newly available hard disk space, be sure to empty the Windows Recycle Bin. Open the Recycle Bin 
from the File menu.

{button ,AL(`Restore trimmed application components;Trim an application',0,`',`')}    See Also



Save files in compressed format - Tells First Aid to compress the files before deleting the originals. This allows you to restore 
them later. If you clear this check box, First Aid deletes the original files.



Generate Log File - Tells First Aid to create a report of removed items. The report is a text file called Fa_uinst.txt, located in the 
directory in which you installed First Aid.



Confirm Each Delete - Make First Aid ask you before deleting each file. If you are deleting only a few items, confirming each 
deletion is a prudent choice.



Confirm Each Restore - Make First Aid ask you before restoring each file. 



Trim an application

1 On the Fix Applications page, right-click an application with enhanced support. Applications with enhanced support are marked 
by a small "+" in the lower-left corner of the application's icon. A shortcut menu appears.

2 Click Trim. First Aid displays a list of application features.

3 Select the features you want to trim.

4 Click Trim. The Trim Applications dialog box displays the list of files associated with the selected feature.

5 Click Proceed. 

6 Click Yes to delete the original copy of the currently displayed file, or Yes to All to let First Aid delete the selected items without 
further prompting. 

Trim Options

{button ,PI(`FIRSTAID.HLP',`trimapp_save')} Save files in compressed format

{button ,PI(`FIRSTAID.HLP',`trimapp_generate_log')} Generate log file

{button ,PI(`FIRSTAID.HLP',`trimapp_confirm_delete')} Confirm each delete

Tip:

The number of applications with enhanced support is growing all the time. To make sure your version of First Aid is as up-to-date 
as possible, use the Update feature on a regular basis.

{button ,AL(`Remove a trimmed application;Restore trimmed application components',0,`',`')}    See Also



16-bit

(see also bit, 32-bit)

A 16-bit microprocessor is any microprocessor that supports a maximum numeric value of 16 bits (65,535) at one time. Any 
larger number must be broken into separate segments. 

When the IBM PC was first released, it was equipped with an Intel 8088 microprocessor, and later upgraded to an Intel 80286. 
These were 16-bit microprocessors, and the operating system designed to run on them (MS DOS and Windows 3.1) were called 
16-bit operating systems by extension. 

In the mid-1980s, Intel introduced its first 32-bit microprocessor—the 80386, and in the years following, 32-bit operating systems 
(operating systems designed expressly for the 32-bit microprocessor) such as Windows NT, and Windows 95, were developed to 
take advantage of its superior features. In addition to its increased performance, the greatest improvement offered by the 32-bit 
processor is the method by which it addresses memory. While 16-bit processors must address memory in segments, 32-bit 
operating systems can access something called a flat memory model, which enables them to address up to 4 GB    of memory—
a tremendously high amount. 

Applications designed expressly for 16-bit operating systems are, by extension, called 16-bit applications. 16-bit operating 
systems like MS-DOS and Windows 3.1 are a dying breed because they cannot keep up with the demanding workload of today’s 
applications. Although Windows 95 can run 16-bit applications, 16-bit operating systems (Windows 3.1 or and lower) cannot run 
32-bit applications. 



32-bit

(see also bit, 16-bit)

A 32-bit microprocessor is any microprocessor that supports a maximum numeric value of 32 bits (4,294,967,295) at one time. 
Any larger number must be broken into separate segments. 

The first 32-bit microprocessor used in IBM-compatible computers was the Intel 80386, which first appeared in the mid-1980s. 
The operating system available at the time, however (MS DOS and Windows 3.1), were based on the older 16-bit 8088 and 
80286 processors, and could not take advantage of the 32-bit architecture. 32-bit operating systems (operating systems 
designed expressly for the 32-bit microprocessor) such as Windows NT, Windows 95 have only begun to surface in the 
mainstream in the past few years. Although Windows 95 does contain 16-bit components, it is nevertheless a 32-bit operating 
system that fully exploits the advantages of Intel’s 32-bit architecture. 

In addition to its increased performance, the greatest improvement offered by the 32-bit processor is the method by which it 
addresses memory. While 16-bit processors must address memory in segments, 32-bit operating systems can access something 
called a flat memory model, which enables them to address up to 4GB of memory—a tremendously high amount.

Applications designed expressly for 32-bit operating systems are, by extension, called 32-bit applications. Because Windows 95 
is backward compatible, it can run 16-bit applications. 16-bit operating systems (Windows 3.1 or and lower), however, cannot run 
32-bit applications. 



architecture

In computer software and hardware, architecture refers to the overall design of a system. 

A system designed with an open architecture allows it to be connected easily to devices and programs of different 
manufacturers.    On the other hand, a system with a closed architecture is difficult to merge with other systems. 



archive 

(see aiso backup, file attributes)

As a verb, archive means to copy files to a long-term storage medium for backup. It can also refer to the act of compressing a 
file. 

As a noun, an archive is a disk or tape or any other storage medium used to hold files that have been archived. In MS DOS 
-based personal computers, archive is a file attribute designed as a precautionary measure to remind the user to back up 
important data. Files with the archive attribute are marked by operating system if they have been modified since they were last 
backed up. 



ASCII

Acronym for American Standard Code for Information Interchange, a coding system that assigns numeric values to letters, 
numbers, punctuation marks, and other characters. 

For example, the ASCII code for uppercase "N" is 78. The ASCII standard is generally used to represent unformatted text which 
is easily transferred from one computer to another. These files are stored in ASCII format are called ASCII files, or text files, and 
are edited using a text editor. Some of the most common ASCII files are Config.sys and Autoexec.bat. 



AT

Acronym for advanced technology.

The AT is an IBM PC model introduced in 1984 including an Intel 80286 microprocessor, a 1.2 MB    floppy drive, and an 84-key 
AT keyboard. ATs are too slow to run most of today’s software, including Windows 95.



Autoexec.bat 

(see also Config.sys)

A batch file used in MS DOS systems to configure software automatically whenever the computer is started.

Autoexec.bat controls the software environment by loading device drivers, applications, and by specifying operating system and 
software settings during startup. A second file, Config.sys, is used for a similar purpose, but to control hardware settings. 
Autoexec.bat and Config.sys are needed by Windows 95 only to support older Windows applications.



AutoFix

A command that instructs CyberMedia’s First Aid to try to repair a problem automatically.



AVI files

Acronym for Audio Video Interleave, a format used for video files in Microsoft Windows. All AVI files have an AVI file name 
extension.



backup

(see also archive)

To copy data onto a separate storage medium (a disk or tape) in case that data is somehow lost. 

There are a host of ways to inadvertently lose data: computers can crash; disk drives can break; electrical power can fail. The 
only reliable precaution you can take is to save your data often and then backup that data to another storage medium. You can 
do this automatically using the Windows 95 Backup feature in First Aid. 



batch file

(see also ASCII file)

An ASCII file containing a sequence, or batch, of operating system commands.

Batch files are useful for consolidating sets of commands that must be executed in a specific order. In MS DOS, a batch file has 
the file extension BAT. The most common batch file is Autoexec.bat, which automatically runs at startup on MS-DOS computers.



baud rate 

(see also kpbs)

A reference to the speed at which a modem transfers data. 

Baud rate is often confused with number of bits per second (bps). Baud rate measures the number of events, or signal changes, 
that occur in one second. Since more than 1 bit can be encoded in a single event, baud rate and bps are not always the same. 
Bps has replaced baud rate as the dominant measure of modem speed, as it is the more accurate measure of the two. 



BBS

Acronym for Bulletin Board System, a computer system that serves as a message center for dial-up users. 

Initially, BBSs were used solely as public or private message boards; a user would use a modem to log on, review messages left 
by others, and post his or her own message. Today most BBSs provide additional services, such as software archives and 
personal email. Most BBSs are geared toward specific interest groups, and messages are usually arranged according to general 
topic. Although many BBSs are operated by government, educational, and research institutions, the vast majority of the 
thousands of BBSs in existence are run by amateur system operators (“sysops”) from their home computers using a single 
modem line. 



BIOS

Acronym for basic input/output system, a set of built-in software routines that work closely with the hardware to support the 
transfer of information between the CPU and its various components, such as memory, disks, modem, keyboard, monitor, and 
printer. 

BIOS is invisible to the computer user, and in MS DOS computers is built into the read-only memory (ROM BIOS). This ensures 
that the BIOS will always be available and will not be damaged by disk failures. It also ensures that the computer will always be 
able to boot itself. 



bit

Short for binary digit, the smallest measure of computer information. 

A single bit can hold either 1 or 0 in the binary number system. All computer information is built on consecutive combinations of 
bits into larger units. For example, a group of eight bits, or a byte, is used to represent a single character in the alphabet. 



bit map

A graphics image consisting of rows and columns of dots.

In bit map graphics, also known as raster graphics, each dot, or pixel, on the screen is equal to one bit of memory. For color or 
shades of gray, more than one bit is required to represent a pixel. When stored as graphic files, bit maps have the file extension 
BMP. Unlike vector graphics, in which objects are constructed as collections of lines rather than patterns of individual dots, bit 
images depend on screen resolution for proper display.



boot disk 

Also called a startup disk, the boot disk contains the startup instructions for your computer. 

The boot disk is usually the hard disk. You should use First Aid to create a backup floppy boot disk in case you can’t start up with 
your hard disk. 



booting the computer

To start or restart the computer. 

A boot can be “cold,” as when a dormant computer is switched on, or “warm,” as when you restart the computer either by using 
Shut Down in Windows 95 or by pressing Ctrl-Alt-Del. 



browser 

A software program that translates HTML (hypertext markup language) files on the Internet into the pictures, text, and hypertext 
that you see on your computer screen.

Browsers provide a means of viewing the contents of nodes and of navigating from one node to another. Netscape, Internet 
Explorer, Mosaic, and Lynx are all browsers for the World Wide Web. They act as clients to remote web server.



bug

Any unexpected defect or malfunction in a program or piece of hardware. 



bus

A collection of wires through which data is transmitted from one part of a computer to another. 

In microcomputers, the term bus usually refers to the expansion bus, which connects various hardware devices, expansion 
boards, disk drives, printers) to the CPU. 



byte 

(see also bit, kilobyte) 

The second smallest measure of computer information, equal to eight bits. It is the equivalent of one letter or character. Hard 
disk size is measured in megabytes (MB) and gigabytes (GB).



cache

A special high-speed storage mechanism in which frequently used data is stored for quick access. 

In most PCs, a cache can be either a reserved section of main memory (RAM) or an independent storage device (disk cache). 
The chief measure of a cache is its "hit rate" -- the percentage of all memory accesses performed by the cache. Since RAM 
caches use high-speed static RAM instead of the slower dynamic RAM, a RAM cache hit takes much less time to complete than 
a normal memory access. 



CD-ROM

Acronym for Compact Disc Read-Only Memory, a technology in which data is stored on a compact disc. 

Compact discs are capable of storing up to 1 gigabyte of data, although typical storage capacity is 630 megabytes. Unlike floppy 
disks and hard disk,the data stored on compact discs is “read only,” meaning that it cannot be erased or written over once it has 
been recorded onto the disk.



chip 

A tiny piece of semi-conducting material (usually silicon) on which an integrated circuit is embedded. 

A typical chip is less than ¼-square inches and can contain millions of electronic components (transistors). Computers consist of 
many chips placed on electronic boards called printed circuit boards. There are many different kinds of chips. For example, CPU 
chips, (also called microprocessors) contain an entire processing unit, whereas memory chips contain blank memory.



clipboard

An area of system memory that holds information temporarily. When you cut information from a text or graphics file, it is held in 
the clipboard before you paste it to a new destination.



CMOS

Acronym for complementary metal-oxide semiconductor. 

The great advantage of the CMOS is its low rate of power consumption. As a result, it is frequently used in devices such as 
laptop computers that rely on battery power. When you turn your computer off, the CMOS continues to maintain information    
such as the date and time.



COM port

(see also parallel port)

Short for serial communications port, the COM port is an input/output channel for certain peripheral hardware devices. 

The term COM port refers to both the external sockets on a computer where serial devices are connected, and to the physical 
location in the computer where communications data enters and exits the CPU. Peripheral serial hardware devices include 
modem, mice, and some printers. MS DOS supports four logical COM ports (COM1, COM2, COM3, and COM4),    most 
computers have only two physical COM ports. 



Config.sys 

(see also Autoexec.bat)

A file used in MS DOS systems to load device drivers and specify hardware settings. 

Config.sys runs every time you start your computer. You can use it to specify settings that determine how the operating system 
interacts with the hardware. 



configuring hardware

A term referring to the general process by which the operating system is set up to recognize and work with hardware.

Typical examples of configuring hardware include adding or changing device drivers, installing new hardware, and adjusting 
resource settings to accommodate a hardware device. 



configuring software

A term referring to the process by which software programs are customized in their operation or tailored to work with a particular 
collection of hardware.



Control Panel

A Windows 95 utility program that allows the user to control parameters such as fonts, display resolution, printer drivers, software 
installation, port connections, keyboard settings, passwords, and system date and time. 



conventional memory

The first megabyte of RAM in DOS-based computers. 

The DOS operating system is limited to using only this memory. However,    there are techniques that can enable the system to 
use a greater amount of memory.



CPU 

Acronym for central processing unit, the "brains" of the computer.

Also known as the microprocessor, central processor, or simply processor, the CPU is the primary gauge of a computer’s 
computational power and therefore its most important element. CPU speed is measured in megahertz (MHz). Oftentimes the 
CPU is incorporated into the computer’s model name. For example, the Millennia Transport P133 contains a 133 MHz Intel 
Mobile Pentium processor.



crash

A general term used to describe any sudden computer failure. 

The two most common computer crashes are system crashes, in which a software program aborts unexpectedly or the computer 
stops working altogether (sometimes called a hang or freeze), and disk drive crashes, in which a disk drive fails and, in many 
cases, the data contained on that drive is lost. Software and hardware malfunctions can occur for many reasons, and in most 
cases the user is not to blame. The best way to prepare for computer crashes is to activate First Aid’s Crash Protector and to 
back up your data on a regular basis.



cross-linked files

An error in which two or more files are using the same area of a hard disk.

Because a cross-linked cluster usually belongs to only one of the files, repairing the cross-linked files most often results in only 
one file remaining usable. The Windows 95 utility ScanDisk can check for and repair cross-linked files. 



data compression

Also called data packing or compaction, compression is a process by which data is stored in a format that requires less space 
than usual. 

Data compression is especially useful in communications because compressed data require less time to transmit than regular 
data. It is also used in backup utilities, spreadsheet applications, graphics, and database management systems to reduce the 
size of stored files. A common file compression standard is ZIP, which is supported by programs such as WinZip and PKZIP. 
Compression is often used to reduce the size of audio and video files as well, since these files are often extremely large. 



default language

The language automatically used by the keyboard when the user does not specify an alternative.

When you purchased your computer, the default language was set to English. You can change the default language from 
Keyboard in the Windows 95 Control Panel. 



default printer

The printer that software programs automatically use when the user does not specify an alternative. 

You can change the default printer by double-clicking the Printers icon in the Control Panel. 



delete

In relation to computer files, the process of erasing a file from a disk. 



desktop

A metaphor for a file system within the Windows environment. 

A desktop usually consists of icon that may portray application shortcuts, files, folders, or various types of document. Icons can 
be organized on the electronic desktop just as real objects on a real desktop, by moving them around, placing one atop the 
other, or even throwing them into the recycle bin. 



device

Any piece of hardware attached to your computer. 

A device may be something inside your computer, such as a hard disk, or external to your computer, such as a printer or display 
screen. 



device driver

A program that controls or regulates a hardware device.

Every devices, whether it be a printer, disk drive, CD-ROM or keyboard, must have a driver program. Many drivers, such as the 
keyboard driver, come with the operating system.      For other devices, you may need to load a new driver when you connect the 
device to your computer.    In DOS systems, drivers are files with a .SYS extension. In Windows, drivers have a DRV file 
extension.



Device Manager

A property page on the System property sheet in the Control Panel that enables you to control the device installed on your 
computer. 

Device Manager can be used to change device drivers, remove device drivers from the system, print a summary of all devices in 
the computer, and print a system summary. 



dial-up networking

Generally speaking, dial-up networking refers to any situation in which a computer system uses a modem to connect over a 
telephone line to a network server. 

When capitalized, the term refers to specific software included in the Windows 95 operating system that enables a computer to 
function as both a remote access services (RAS) server and client. A computer running Windows 95 and equipped with a modem 
can use dial-up networking to connect to a remote server over a telephone line and access shared resources on the network to 
which the server is connected. 



Disk Defragmenter

(see also file fragmentation)

A utility program used to reorganize or defragment a disk on which data is stored.

Fragmentation of data occurs naturally when creating, deleting, or modifying files. When a file becomes too large for the space 
allotted, the operating system automatically splits the file into two or more fragments. These fragments may be placed in 
separate locations on the disk, depending on which spaces on the disk are occupied. Because fragmentation slows the speed at 
which data is accessed, defragmenting a disk can significantly improve its performance.



disk storage 

The number of bytes available for storing data or programs on a disk. 

Most 3.5” floppy disks have a disk storage capacity of 1.44 megabytes. Hard disk storage size varies greatly and increases 
every year. 



DLL 

Acronym for dynamic link library, a type of file that contains instructions used as an additional resource by a particular 
program. 

DLLs are “dynamic” because they link to the main program at the moment they are needed rather than in advance. The 
advantage of DLLs is that they can be used by more than one program. DLL files are distinguished by the .DLL file extension.



document

A file containing data, created or changed from within an application program.



DOS 

(see also MS DOS)

Acronym for disk operating system, a generic term for any operating system loaded from disk devices. 

The term DOS was used originally to differentiate between disk-based operating systems and primitive operating systems that 
depended entirely on memory or magnetic or paper tape. Today it most often refers to Microsoft's MS-DOS, the standard 
operating system for IBM-compatible computers. Even today, MS-DOS is included with Windows 95.



double-click

Pushing and releasing the left mouse button twice in rapid succession.



download

The process of copying a file to a computer from a network, online service or bulletin board. 

The opposite of download is upload, which means to copy a file from your own computer to another. 



drag and drop

To drag is to select an object—an icon, a highlighted paragraph, or something similar—and move that object to a new location. 
Dropping is letting go of the mouse button to place the selected object in its new location.



email

Short for electronic mail, the transmission of messages over a communications network.

Email is essentially an electronic version of the interoffice memo or the postal service. Used on both LANs and larger networks, 
email allows users to send and receive not only text messages, but attachments as well. Attachments are files containing any 
kind of data, even graphics and voice messages. Delivered messages are stored in electronic mailboxes assigned to users on 
the network and can be viewed, saved, forwarded, printed, or deleted by the recipient. Most computer networks and all online 
service offer email, and most also have the ability to exchange email with users of other systems. Regardless of geographical 
distance, it usually takes only seconds or minutes for email to arrive at its destination. 



expansion board

A printed circuit board inserted inside a computer to expand its capabilities. 

Expansion boards are also called adapters, cards, add-ins, and add-ons. Examples include video adapters, sound cards, and 
internal modems.



FAT

Acronym for File Allocation Table.

A table used by the operating system to locate files stored on either a floppy or hard disk. Due to the naturally occurring process 
of fragmentation, a file may be scattered into many sections on the disk. The FAT keeps track of all these pieces. 



field

A space set aside for a specific piece of information. 

Forms contain many fields, each labeled with a "field name" designed to accept a particular piece of information. For example on 
registration forms, the areas allocated for first name, last name, street address, city, state, etc., are all fields. Fields also have 
attributes; some are numeric, some textual and can vary in length. Fields are especially helpful in the realm of database 
management, in which specific information can be accessed and retrieved easily. 



file attributes

Restrictive labels attached to files that describe and regulate their use. 

Examples of file attributes include hidden, system, read-only, archive, and so forth. MS DOS, file attributes are stored in the file’s 
directory entry. 



file fragmentation

A frequent condition in which files are separated on a disk into small, separated fragments. 

File fragmentation is a natural consequence of creating, deleting, or modifying files on a disk over time. When a file is saved on a 
crowded disk that no longer contains contiguous blocks of free space large enough to hold it, the file is automatically split into 
two or more chunks, or fragments, and placed on separate parts of the disk. If left untreated, file fragmentation can slow down a 
disk’s access speed. The utility Disk Defragmenter can detect and fix file fragmentation problems.



file name

The name the user gives to a file for purposes of identification and storage.

In MS DOS and Windows 3.1, a file name can contain up to eight characters followed by a period (.) and an extension of up to 
three letters. In Windows 95, file names can be as long as 256 characters. 



file name extension

In MS DOS computers, the portion of a file name following the point (.) that indicates the kind of data stored in the file.

File name extensions are usually limited to three letters in length. They can be assigned by the user, as in the file name 
DATA.OLD, or they can be assigned by (and have special meaning to) a program, as in the case of Microsoft Word, which 
automatically assigns its documents the extension DOC. Other examples include "c" for C source    code, "ps" for Postscript files, 
and "txt" for plain text. These special file name extensions represent an association between a file and an application, so that 
when the user double-clicks the file, Windows automatically launches the associated application. By default, Windows 95 does 
not display file name extensions, but you can change this by selecting Details in the View menu in Windows Explorer.



font

A design for a set of characters.

A font is the combination of typeface and other qualities. For example, Times Roman is a typeface that defines the shape of each 
character. Within Times Roman, however, there are many fonts to choose from, representing different combinations of attributes 
such as size, pitch, spacing, and so on. 

Most applications enable you to choose from many different fonts. In addition to the fonts automatically supported by your printer, 
additional fonts can be added by loading them from software programs or by plugging additional font cartridges into your printer. 
All fonts are encoded either as bit-maps or vectors. In a bit-mapped font, every character is represented by an arrangement of 
dots. In vector graphics fonts, which are better suited to high-resolution printers, characters are defined geometrically. Vector 
fonts are referred to as “scalable” because the size of the characters can be increased or decreased simply by altering the 
coordinates. The best-known scalable-font systems are PostScript and TrueType.



FTP 

Acronym for File Transfer Protocol, a standard that allows a single computer to transfer files to and from another computer over 
a TCP/IP network. 



GPF 

Acronym for General Protection Fault, an addressing error caught by the CPU’s memory protection hardware. 

A GPF occurs when a program tries to access memory that doesn’t belong to it. A GPF can be serious because the operating 
system closes down to protect its own integrity at the expense of the user’s data. GPFs cannot be attributed to any expected 
condition. Although these errors occur due to conflicts in memory. installing additional memory will not prevent the problem.



GUI

Acronym for graphical user interface, an interface designed to make a computer easier to use by using picture icons instead of 
a command line for user input. 

The first GUI was designed by Xerox in the 1970s. However, due to the high cost of the advanced hardware required, GUIs did 
not become an industry standard until the advent of the Apple Macintosh in the 1980s. 



hard disk

A fixed magnetic disk on which computer data is stored. 

A hard disk is composed of several platters stacked atop one another. Hard disks are considerably faster than floppy disks, with 
access time of 15 milliseconds or less. Moreover, while floppy disks typically contain 1.4 megabytes, today’s hard disks often 
have capacities exceeding 1 gigabytes. 



hardware profile

A list of all the hardware comprising a particular system, including its make and model. Software programs must be provided with 
a hardware profile in order to know how to communicate with various hardware components successfully.



hexadecimal

Refers to the base-16 number system, which is made up of the numbers 0 - 9 and the letters A - F. 

The hexadecimal numbering system is often used by programmers to represent bit -masks, machine addresses, and other low-
level constants. It is particularly well-suited to computers because it can represent a single byte (8 bits, or one character) as two 
consecutive hexadecimal digits. 



hidden file

(see also file attributes)

A file with the hidden attribute activated so that it does not appear in a normal listing of the files contained in a directory. 

Certain files critical to the operating system are generally hidden so that the user will not accidentally corrupt or delete them. In 
MS DOS these files include MSDOS.SYS and IO.SYS. The user can hide and unhide any file manually by changing its 
attributes.



hot key

A single key or combination of keys that perform a function which would otherwise require several key strokes or mouse 
movements.

Hot keys can be user-defined or they can be built into programs so that frequent users can work directly from the keyboard and 
not rely upon a mouse. Virtually all of Windows 95's basic functions and most application functions can be executed using hot 
keys rather than mouse clicks. For example, Ctrl+C usually copies selected objects to the clipboad and Ctrl+V pastes the 
contents of the clipboard. MS DOS systems, you can use hot keys to switch to a memory-resident program (TSR) such as a pop-
up calculator, notepad, or antivirus. The key is called “hot” because the program it switches to is ready and waiting, or warmed 
up. 



HTML

Acronym for hypertext markup language, the language used to author or create document on the World Wide Web.



hypertext

A system in which objects (e.g. graphics, sound, video, text, programs) can be connected to one another.

Because these various objects are connected, they can be accessed from within one another by clicking a hypertext link. For 
example, you might click on the phrase Civil War and be connected to pictures, text, and videos concerning the Civil War. 
Hypertext is useful for browsing through databases with large amounts of information, such as this glossary. 



IBM PC

This term is most often used in a broad sense to include not only those computers produced by IBM, but the greater family of 
computers that conform to the IBM-compatible specification. 

The IBM PC standard accounts for over 80 percent of all computers in existence today. These computers are variously called 
IBM clones, IBM compatibles, or simply compatibles. 



icons

Small pictures that represent commands, files, or windows.



INI

A file name extension used to indicate files containing configuration information for applications or for Windows itself. 

INI files are generally used to store values used by a program when it is run, installed or accessed by the user. The INI file plays 
an important role in Windows 3.1, but most of its functions have been replaced by the Windows registry in Windows 95.



ink-jet printer

Prints by spraying ionized ink at a sheet of paper.    The ink is directed by magnetized plates to form desired shapes and are 
capable of producing high quality print. 

Ink-jet printers generally provide a resolution of 300 dots per inch, although some newer models offer higher resolutions.    One 
drawback is, since they require a special type of ink, the printed page is inclined to smudge if inexpensive copier paper is used.



interlacing

A video display technique in which the electron guns draw only half the horizontal lines with each pass (i.e., all odd lines on one 
pass and all even lines on the next pass). 

Because an interlacing monitor refreshes only half the lines at one time, it can display twice as many lines per refresh cycle, 
which results in greater resolution. However, the reaction time of interlacing is relatively slow, so programs that depend on quick 
refresh rates (i.e., animation and video) may experience flickering or streaking. Generally speaking, non-interlacing monitors 
perform better than interlacing monitors of the same resolution. 



Internet 

Abbreviation for Internetwork. 

Generically speaking, an Internet is any set of computer network joined together through gateways that handle data transfer. 
When capitalized, the term refers to the collection of networks and gateways that use the TCP/IP suite of protocols. The Internet 
currently has over 30 million users worldwide. 



ISP

(see also online service)

Acronym for Internet Service Provider, a term used for any organization that provides access to the Internet. 



IRQ 

Acronym for interrupt request line, a hardware line over which devices like I/O ports, printers and disk drives can send interrupt 
signals (requests for service) to the CPU. 

IRQs are part of the computer’s internal hardware. There are a limited number of IRQs, and each one is rated in a hierarchy so 
that the CPU can determine the relative importance of competing requests. 



jumper

A metal bridge that allows an electrical circuit to function.

Typically, a jumper consists of a small plastic two-pronged female plug that fits over a pair of protruding pins to configure various 
hardware devices(e.g., expansion boards, sound cards, hard drives).    Changing the placement of a jumper plug by placing it 
over a different set of pins will change the board's parameters. 



kbps

(see also baud rate) 

Kilobits per second, a measurement of modem speed.

Most modems available on the market operate at speeds of either 14.4 kbps or 28.8 kbps. 



kilobyte (KB)

(see also bit, byte)

Unit of measure for memory equal to 1,024 bytes. 

On the surface, a kilobyte appears to be 1,000 bytes. In fact, it's 1,024 bytes. This has to do with the fact that all computers use 
the binary system and use multiples of 8. Therefore, a megabyte (MB) is 1,048,576 bytes, a gigabyte (GB) 1,073,741,824 bytes, 
and a terabyte, still chiefly a theoretical number, represents over a trillion bytes: 1,099,511,627,776.



LAN 

Acronym for local area network, a group of computers and other devices covering a limited area that interact throughout a 
common communications link. 

LANs are generally comprised of microcomputers and a limited number of shared devices such as laser printers and disk drives. 
In order to connect to a LAN, each computer must use a certain data-link and communications protocol. LANs are usually small-
to-medium-sized office networks or large networks contained within a single physical location.



laser printer

A printer that uses a laser beam to produce an image on an electrically charged drum, which is then rolled through a reservoir of 
toner and transferred to the paper through a combination of heat and pressure. 

Most laser printers offer resolutions ranging from 300    to 1,200 dpi (dots per inch), and are capable of printing an almost 
unlimited variety of fonts. All laser printers are equipped with built-in RAM, which in most cases can supplemented. For a 600-dpi 
graphic output, you need at least 4 MB of RAM. Laser printers are much quieter than dot matrix or daisywheel printers because 
they print using a "nonimpact" technology. 



LCD

Acronym for liquid crystal display, a display technology typically used in digital watches and portable computers. 

LCDs utilize two flat layers of polarizing material with a liquid crystal solution sandwiched between. An electric current is then 
passed through the liquid which causes the crystals to align, essentially blocking the light. Although the quality of    the LCD is 
inferior to other display technologies, its low power consumption still makes it a popular choice for many portable electronic 
devices.



log file

A file used to store transaction information. 

Typically, log files are automatically created by programs in order serve as records of the actions performed by the program. This 
is true in the case of First Aid, which creates its own log file to record problem fix and undo actions.



logging off

Also called logoff or logout, logging off is the process of terminating a session with a computer accessed through a 
communications line. Logging off is not the same thing as shutting off the computer.



logging on

Also called logon or login, logging on is the process of identifying oneself to a computer after connecting to it over a 
communications line. When logging on, the computer usually requests the user’s name and passwords.



memory 

(see also RAM)

Broadly speaking, memory can refer to external storage systems such as disk drives, but in most cases it refers to the amount of 
random access memory (RAM) in your computer. 



memory address

(see also byte)

A specific location where data can be found, usually in main memoryor on a disk.

Memory is somewhat like an array of storage bins, each identified by a unique numbered address.    By specifying a memory 
address, programmers can access a particular byte of data.    Disks are divided into tracks and sectors, each of which has a 
unique address. Usually, you do not need to worry about addresses unless you are a programmer.



MHz

Short for megahertz. One MHz represents one million cycles per second. 

"Clock speed" or the speed at which microprocessors can execute commands is measured in megahertz.    For example, a 
computer with a clock speed of    75MHz executes 75million cycles per second or 75 million instructions per second. 



MIDI

Acronym for Musical Instrument Digital Interface, a hardware specification and communication standard adopted by the 
electronic music industry that represents and transmits sounds, enabling music synthesizers and musical instruments to 
communicate with computers.



modem

Short for modulator/demodulator, a modem translates digital information (which the computer understands) into analog 
information (which the telephone system requires) in the form of tones which it sends over a telephone line to another modem. 
To understand each other, both modems must be using the same protocols. Modems allow an individual computer user to 
communicate electronically with other computers, either through a direct computer-to-computer link, through dial-up networking, 
or by connecting to an ISP, BBS or online service. 



MS-DOS

Acronym for Microsoft Disk Operating System.

The original MS-DOS, closely based on the older CP/M operating system,    was designed by Tim Patterson for the Intel 8088-
based IBM PC. Also known as PC-DOS or simply as DOS, MS-DOS is a single-user operating system with a command-line 
interface that runs one program at a time and is limited to working with one megabytes of memory. Newer operating systems 
such as Windows 95 and OS/2 Warp do not depend on DOS, although they are compatible with DOS-based programs.



MSN

(see also ISP)

Acronym for the Microsoft Network, Microsoft’s Internet service provider (ISP). 



multitasking

The ability to execute more than one task (program) at the same time. 

Multitasking refers to the actions of a single computer that switches from one program to another so quickly that it can run 
programs simultaneously. There are two basic types of multitasking: preemptive and cooperative. In preemptive multitasking, the 
operating system (OS/2, UNIX, Windows 95, and Windows NT) parcels out CPU time slices to each program. In cooperative 
multitasking (Windows 3.1 and Macintosh), each program can control the CPU for as long as it needs to. 



network

A group of two or more computers connected to each other by a communications link. 

There are two kinds of network links. The first is a permanent physical link involving cables, and the second is a temporary link, 
usually over telephone lines. Most networks consist not only of computers, but also shared resources such as printers, mass 
storage devices and servers. Networks range in size from small local area networks (LANs) to networks such as the Internet, 
made up of many different computers distributed over a large geographic area. Regardless of their size, all networks have the 
same general purpose—to provide a means by which information and resources can be shared by more than one computer. 



network server

A computer running administrative software that provides some service for other computers connected to it via a network.

A server makes resources, such as printers and disk drives, available to computers acting as workstations (or clients) on a 
network. 



node 

Any device connected to a network and capable of communicating with other network devices. A node can be a computer or a 
shared resource such as a printer or disk drive. 



online/offline

The condition of being actively connected (on-line) or disconnected (off-line) to a printer, a local area network, or a remote 
computer or network such as the Internet.



online service

A business that provides subscribers with a wide variety of services and content. 

Online services provide an environment in which subscribers can communicate with one another, either by exchanging email 
messages or by participating in on-line conferences (forums). In addition, the service provides users with third-party information 
such as stock quotes, news stories, magazine and newspaper articles, and so on. All of the major on-line services—America On-
Line (AOL), CompuServe, Prodigy, and Microsoft Network (MSN)—charge a monthly (and, in some cases, hourly) subscription 
fee for use of their service. The Internet is not an on-line service per se because it is not centrally controlled by any one 
organization and is not operated for profit. Subscribers typically connect to on-line services over a telephone line using a modem. 



operating system (OS)

The programs or collections of programs which act as translators between a computer's processing chips and programs 
designed to run on them. 

The operating system is the most fundamental piece of software on a computer. It manages basic computer operations like disk 
input and output, video support, keyboard control, and many internal functions related to program execution and file 
maintenance. Examples of operating systems include CP/M, DOS, Novell NetWare, Windows 95, Windows NT, OS/2 Warp, 
UNIX and Macintosh's OS 7.0. 



parallel port

(see also port, COM port)

A hardware channel for connecting to an external parallel device, such as a printer. 

Parallel ports use 25-pin connectors and are used almost exclusively by printers. 



password 

A security measure used to restrict access to computer systems and/or sensitive files. 

Passwords usually take the form of a unique string of characters selected by the user as an identification code.    After typing the 
password, if the system recognizes it as legitimate the user gains access to the secured location.



path

The route an operating system follows in order to find, store, and retrieve specific files on a disk.

A path includes the drive, directory, subdirectory, folders and subfolders that contain a file.    For example, C:\Program 
Files\CyberMedia First Aid\FAP32.exe is the path taken to access the First Aid program, where Program Files is the directory, 
CyberMedia First Aid is the subdirectory and FAP32.exe the actual file.



peripheral

Also known as a component or peripheral device, a peripheral is any piece of hardware attached directly or indirectly to your 
computer. 

Peripherals include keyboards, video display, mice, printers, microphones, speakers, etc.



Plug and Play 

A feature offered by the Windows 95 operating system which allows for on-the-fly plug-in and removal of peripheral hardware.

The idea behind Plug and Play is that both the BIOS and operating system cooperate in attempting to identify new pieces of 
hardware, and pre-configure them to eliminate the possibility of conflict between devices. Plug and Play might have been a stock 
term for describing hardware or software that pops into a computer and configures itself with little or no user intervention, but 
Phoenix Technologies, Compaq and Intel have trademarked the term, hoping it becomes a way of life for computer users.      
However, Plug and Play is not something that comes standard with every computer, a fact which has created a great deal of 
confusion and frustration among computer users.



pixel

Short for picture element, a single point in a graphic image. 

The quality of a monitor often depends on its resolution, that is, how many pixels it is capable of displaying. VGA monitors 
display 640 x 480 (approx. 300,000 pixels). SVGA monitors display 1,024 x 768 (approx. 800,000 pixels). True Color monitors 
utilize 24 bits per pixel, making it possible to display more than 16 million different colors. Pixels are arranged in rows and 
columns, close enough together to appear connected. Each pixel on a color monitor is actually composed of a red, a blue, and a 
green dot. However, when the three dots do not accurately converge, the resulting picture appears fuzzy.



port

Also known as I/O (input/output) port, a channel through which data is transferred between the CPU and a peripheral device 
such as a printer. Examples of ports include parallel port, serial (COM) port, and game port. A port    is a physical location (usually 
in the back of the computer) into which you plug peripheral equipment. 



protected mode

A type of memory utilization available on Intel 80286-and-later model microprocessors. 

Protected mode allows each program to be allocated a unique section of memory, and thus protect it from interference from 
other programs. It also allows multitasking, which enables the microprocessor to switch from one program to another so the 
computer can execute several programs at once. Only sophisticated operating systems such as Windows 95, and UNIX can run 
in protected mode. DOS, for example, cannot support the protected mode feature directly.



protocol

The speed, number of stop bits, and other data used by a modem to send information. In order to communicate successfully, the 
sending and receiving modems must use the same protocol.



RAM 

Acronym for random access memory, the type of computer memory that can be accessed randomly; that is, any byte of 
memory can be accessed without touching the preceding bytes. 

RAM has many other names, such as main memory and system memory. The word "random" is used because RAM chips are 
designed to be accessed at any point by the CPU with virtually the same amount of speed. The 500,000th bit of a one megabit 
chip can be accessed as quickly as the first bit.    RAM differs from ROM (read-only memory) in that RAM can be erased and 
rewritten thousands of times a second whereas data in ROM is permanent.



Recycle Bin 

Application in Microsoft Windows 95 that acts as a safeguard by automatically saving a copy of deleted files. Using the recycle 
bin, the user can either recover previously deleted files or permanently delete them. 



resources

In Windows, the “resources” refers to system memory. Depending on the context, resources is also a general term denoting any 
accessible source of supply or support. In the case of networks, this may take the form of shared peripherals such as printers 
and storage devices. 



right-click

Pushing and releasing the right mouse button, as opposed to the left. 



ROM

Acronym for read-only memory, which is memory that can only be read and not be removed.

ROM, referred to as non-volatile storage, retains its contents even after the computer has been shut down. Typical ROM 
includes critical programs such as the program that boots the computer. In addition, ROMs are used in calculators, 
semiconductors, integrated circuit memories, CD's and peripheraldevices such as laser printers, whose fonts are often stored in 
ROMs. RAM, on the other hand, is volatile. 



ScanDisk

A utility program that you can use to scan a disk for defects and repair many of those defects. 

Both DOS and Windows 95 include a version of ScanDisk. It is important to use the Windows 95 version because older versions 
do not ensure the security of long file names. 



semiconductor

A material through which electrical current can flow, ranking somewhere between a conductor and a nonconductor (insulator).

Computer chips, both for CPU and memory, are composed of semiconductor materials. The most common semiconductor 
materials used in electronics are silicon, arsenate, gallium and germanium. Semiconductors make it possible to miniaturize 
electronic components because they are small, fast, and require low amounts of energy. 



shortcuts

A special type of file in Windows 95 that is represented by an icon and points to folders, applications, documents, and other 
objects. 

Shortcuts are separate files that provide a quick way to access the items you use often. You might create a shortcut on your 
desktop to a spreadsheet, for example. When you double-click on the shortcut icon, Windows 95 locates the spreadsheet 
program and launches it based on the information it finds in the shortcut file. If you create, change the name of, or delete a 
shortcut, you will only affect the link to the program, not the program itself. 



S.M.A.R.T.

Acronym for Self-Monitoring, Analysis and Reporting Technology System, a problem-detection technology built into certain 
hard disks. 

S.M.A.R.T. uses a series of diagnostics to monitor the internal operations of your hard drive. If S.M.A.R.T. detects a potential 
problem, First Aid’s S.M.A.R.T. Disk Monitor alerts the user so that the drive can be fixed or replaced before a crash occurs and 
data is lost. 



sound card

An expansion board (or, in the case of a laptop, a PC card) that enables a computer to produce and recognize sound. 

Sound cards produce sound through speakers connected to the card and record sound through a microphone connected to the 
computer. Nearly all sound cards support MIDI, a standard for representing music electronically.



SVGA 

(see also VGA)

Acronym for super video graphics array or super VGA. 

A video display standard for IBM PC compatible personal computers designed to offer greater resolution than VGA. There are 
several varieties of SVGA, each providing a different resolution: 800 x 600 pixels, 1024 x768 pixels, 1280 x1024 pixels, or 1600 
x1200 pixels.    All SVGA monitor can support a palette of 16 million colors, however the number of colors that can be 
simultaneously displayed is limited by the amount of video memory installed.



swap file

A hidden file used by the Windows operating system for swapping segments of data memory to disk.

Swapping is a useful technique that enables a computer to execute programs and manipulate data files larger than the main 
memory.    It copies as much data as possible into main memory, and leaves the rest on the disk. Whenever the operating system 
needs additional data from the disk, it exchanges a portion from the main memory with a portion of data on the disk.



system files 

System files are files the computer automatically loads while booting up. 

These important files transmit instructions to the computer concerning the use of memory, the location of essential files, and 
what software and hardware is configured for your system. System files are also known as startup files, not to be confused with 
the StartUp folder, which is the list of files that appears when you click the Start button in Windows 95.



taskbar

The taskbar is an important feature of the Windows 95 desktop. It contains the Start button, which brings up a menu from which 
you can start applications, open documents, and open the Control Panel and Explorer. It    also acts as a task-switcher, enabling 
you to switch between running applications, which appear on the taskbar itself as icons. To switch to a particular application, just 
click on its button on the taskbar. The right edge of the taskbar, called the tray, displays various status indicators, such as the 
current time and the Windows Guardian icon.



TCP/IP

Acronym for Transport Control Protocol/Internet Protocol. The standard protocols used to connect to a network server or 
Internet service provider by dialing in over a telephone line. 

This communications protocol was originally developed by the Department of Defense.    TCP/IP is actually two separate 
protocols (TCP and IP) however, they are almost always used together.    Any computer accessing the Internet probably uses this 
protocol.



text editor

A program that allows you to write and edit files that do not require formatting. 

Text editors, such as Notepad and WordPad, save text is ASCII file (text-only) format. Since system files like Config.sys and 
Autoexec.bat are ASCII files, they should be altered using a text editor. 



TSR

Acronym for Terminate and Stay Resident.    A type of DOS utility which, once loaded, will remain in memory.

Calendars, calculators, spell checkers, and notepads are often set up as TSRs so they can instantly be accessed from within 
another program. TSRs are sometimes called pop-up programs. TSRs also reduce the amount of memory available. 
Furthermore, not all TSRs interact well with each other and difficulties may arise if too many TSRs are kept in main memory at 
once.



UNIX

Operating system created at Bell Laboratories.

UNIX was based on the C language and engineered for portability across hardware platforms and is considered to be the most 
flexible and powerful operating system in existence today. There are two major types of UNIX: System V, developed by AT&T, 
and BSD 4.x, created at the University of California at Berkeley.    The former is the basis for most high-end corporate and 
industrial UNIX systems, while the latter is the popular choice with smaller businesses and institutions.    UNIX is rarely used on 
home computers, but its use is growing as computers grow more powerful.



URL

Acronym for Uniform Resource Locator, a standard for specifying a location on the Internet. 

URLs are essentially addresses of destinations on the Internet. Used extensively on the World Wide Web, URLs can be 
accessed from HTML documents by clicking a hypertext link. Here is CyberMedia’s URL: http://www.cybermedia.com



utility

A program that performs a specific task, most often related to managing system resources and devices.

Unlike applications, such as word processors and spreadsheets, utilities are generally smaller and designed to perform a single 
task or series of tasks. Examples of utilities include antivirus, file managers, memory managers, and so on. Operating system 
usually contain a number of utilities. Windows 95, for example,    includes ScanDisk, Disk Defragmenter, Explorer, Backup, and 
many others. 



VGA

Acronym for video graphics array, the very first product name of IBM's display board. 

A display standard for IBM PCs, with 640 x 480 pixels in 16 colors. There is also a text mode with 720 x 400 pixels. Previous 
versions included the color graphics adapter (CGA) and the enhanced graphics adapter (EGA).



video display

A video display is any display screen device connected to a computer’s video output. 

The term monitor generally refers to self-contained video displays containing a cathode-ray tube, such as those used with 
desktop computer systems. 



virtual

A term often used in the computer industry to indicate that which is not real. It distinguishes the conceptual from that which is 
tangible. For example, a computer aided design image of a car is virtual, as opposed to the physical car itself, which is real.



virtual memory 

An imaginary memory area supported by Windows (not DOS) which is used as a substitute for physical memory when there is 
not enough physical memory available. 

Actually, "virtual" memory is a misnomer.    It is "real" memory, since the hard disk is used in exactly the same way as memory 
chips are.    But because of the difference in access speed between the swap file memory (where virtual memory is stored) and 
actual machine memory, the data on the hard disk is referred to as "virtual" memory. Windows 3.1 and Windows 95 use virtual 
memory dynamically, by varying the swap file size as the needs of the system change.    If the size is fixed by the user, it then 
becomes a permanent swap file. 



virus 

A computer program that replicates itself, written with the intention of damaging your computer without your knowledge. 

Viruses are often spread inadvertently when computer users exchange computer data or communicate with other computers 
over a communications link. Some viruses do their damage by reproducing until they occupy all available memory. Other viruses 
can do more severe damage by deleting files or even reformatting your entire hard disk. To combat viruses, antivirus programs 
were developed to detect and remove known virus types. 



VxD

Acronym for virtual driver where the middle variable is a real or virtual devices, as in virtual hard disk driver.

A virtual device can be a real device, such as your keyboard, or it can be an additional feature or service provided by the VxD, 
such as antivirus protection. VxDs are a vital component of Windows. They are complicated programs that access the very heart 
of the operating system. 



WAV

Short for WAVE, which stands for Waveform Audio File Format, a digital audio standard that MS DOS -based computers can 
understand and manipulate.

The WAV standard was developed by Microsoft and IBM, and is used extensively in the Windows operating system environment. 
WAV files can be identified by their .WAV file name extension. 



window

A subdivided area of the video display screen. 



Windows 

General term for Microsoft Windows, a multitasking graphical user interface environment that was originally developed to run on 
MS DOS -based computers. 

When Windows was first introduced in 1985, it was so slow it garnered the nickname “Windoze.” In contrast to earlier versions of 
Windows, Windows 95 is a complete operating system rather than a graphical user interface (GUI) running on top of MS-DOS. 
Windows 95 provides 32-bit application support, pre-preemptive multitasking, and built-in networking.    It includes MS-DOS 7.0, 
but does not depend on it to operate.

Windows 98, the successor to Windows 95, supports newer technologies and improves operating system performance and 
stability.



Windows NT 

Microsoft's 32-bit multitasking operating system designed for high performance network-based computing.    NT stands for New 
Technology. 



World Wide Web (WWW)

A series of Internet network server that support documents formatted in HTML. Each document, or web page, can access other 
web pages, as well as graphics, video and audio files, thereby creating a “web.” 

The World Wide Web originated from the CERN High-Energy Physics laboratories in Geneva, Switzerland. It was introduced to 
the public in 1991, and since that time the number of users has mushroomed. Every web page has its own address, called a 
URL. 



zip files 

A data compression format for computers.

PKZIP and PKUNZIP are DOS utilities for compression and expansion of files. Files that have been compressed with PKZIP end 
with a .ZIP extension.    WinZip is the Windows version. Zip files can be transported and stored more efficiently than ordinary files 
simply because they occupy less disk space.



Check-Up Completed

The Check-Up Completed page appears when you have completed Check-Up. 

The Check-Up Completed page has two buttons:

n Yes—If you are still experiencing problems, click Yes to go the Advisor, the next stage in First Aid. 

n Finished—If your problems have all been solved, click Finished to return to the First Aid Desktop.



The Check-Up Report

The Check-Up Report displays the results of a Check-Up. The Check-Up Report divides problems into three categories:

n Critical Problems—These problems are serious and should be attended to immediately. 

n Potential Problems—These are irregularities that First Aid thinks may cause a problem down the road. It's a good idea to 
address potential problems as soon as possible before they turn into critical ones. 

n Tips & Performance Issues—These are suggestions for improving the performance of your computer system. Tips & 
Performance Issues are completely optional. You cannot AutoFix Tips & Performance Issues from the Check-Up Report. To 
implement the suggested changes, click View to go to the Tips & Performance Issues page. 

The Check-Up Report is dynamic in the sense that it is always up-to-date. For example, if the Check-Up Report reads "3 Critical 
Problems Found" and one of problems is subsequently fixed, it will then read "2 of 3 Critical Problems Fixed." You can always 
return to the Check-Up Report to get the current status of your outstanding problems.

The Check-Up Report contains the following buttons:

n View—Displays details about the category’s problems. This will take you to the Critical Problems page, the Potential Problems 
page, or the Tips & Performance Issues page respectively. In these category-specific views, you can AutoFix individual 
problems and groups of problems. 

n Print—Print a Problems report. The report includes all critical problems, potential problems, and tips & performance issues 
found by Check-Up.

n AutoFix—To fix as many problems as possible automatically, click AutoFix. (If you want to take a closer look at the problems 
before you fix them, click View.) First Aid fixes as many of the Critical and Potential problems as possible. If every problem has 
not been fixed, a dialog box appears with the following message:
First Aid was not able to automatically fix all of your problems. For assistance with the 
remaining problems, do the following: (1) Click OK to return to the Check-Up Report. (2) 
Click View for the appropriate problem area. (3) For more information, click Fix Info."

n Finished—Exits Check-Up. If you are still having problems, First Aid will ask you if you want to enter the Advisor.

To get to the Check-Up Report

n From the First Aid Desktop, run a check-up. 

n If you've already run a check-up, you can go back to the Check-Up Report by navigating backwards with the Back button or by 
clicking the Check-Up Report tab in the upper-left corner of most pages.

Note

The Check-Up Report remembers the results of your last Check-Up only until you run another Check-Up or exit the program.



Settings

The Settings dialog box lets you customize which parts of your computer you want to check. First Aid maintains different settings 
for general Check-Up and component-specific checks. By default, general Check-Up is configured to perform the most detailed 
check possible without requiring assistance from the user (inserting an audio compact disc, for example), while the component-
specific check is set by default to perform the most thorough check possible. Any of these settings can be changed at any time 
without affecting the other.

The Settings dialog box contains:

n List of checks—Displays the checks that can be performed in an expandable/collapsible list. The checks are grouped by 
category. Click “+” to expand the list. Select a check box to run a check or category of checks. Clear a check box to skip a 
check or category of checks.

n Show Settings For—Click All Components to display the list of checks that are performed when you click Check-Up on the 
First Aid Desktop.
Click a component in the list and click Selected Components to display the list of checks that are performed when you check 
the individual component.

n Check All—Click Check All to select every check box. This is Check-Up's maximum configuration. Under this configuration, 
Check-Up asks you to participate, when necessary, during the checking process—such as insert an audio CD.

n Defaults—Click Defaults to return to the settings installed originally.

n OK—When you've finished configuring Check-Up, click OK. First Aid remembers your new settings.

n Cancel—Exit without saving the settings.

To change Check-Up settings

n From anywhere in the program, click Options on the menu bar, point to Settings, and click Check-Up.

n From the First Aid Desktop, right-click the large button labeled Check-Up, then click Settings. The Settings dialog box controls 
which checks are performed when you click the Check-Up button.

To change component check settings

n From the First Aid Desktop, click a computer component, then click Settings. The Settings dialog box contains only the checks 
that apply when you check this individual component. 



CPR

The First Aid CPR (Computer Program Reactivator) dialog box presents a list of open programs. To reactivate a frozen 
application, select it and click Reactivate.

To get to the First Aid CPR dialog box

1      Right-click   the blue cross  in the lower-right corner of your screen. A menu appears.

2 Click Reactivate Application

Tip

If the blue cross does not appear on your screen, First Aid Guardian is disabled. 

{button ,JI(`FIRSTAID.HLP>second',`secondary_Enable_or_disable_Windows_Guardian')} Click here for help on turning on 
First Aid Guardian.



First Aid Properties

To get to the First Aid Properties dialog box

n From anywhere in the program, click Options on the menu bar, point to Settings, and click First Aid.

Customize First Aid settings

1 Click a tab to bring it to the front.

2 To change Properties, follow the instructions on each tab. You can switch between tabs without closing.

3 When you are finished, click OK.

Tip

For more information about an item on the screen, right-click the item and click "What's this?"



Fix Applications

The Fix Applications page allows you to trim and run a check on individual applications. When you first view the Fix Applications 
page, it scans your computer and builds a list of the installed Windows applications. There are three buttons in Fix Applications:

n Scan—If you have added or deleted any applications since you last ran Fix Applications, click Scan. First Aid will run a fresh 
scan of your computer and update the list of applications.

n Check—To run a check on a particular application, double-click the application's icon, or click the icon and click Check.

n Cancel—Cancel a check in progress.

To get to Fix Applications

1 On the First Aid Desktop, click the Generic Software box located in the lower-right corner. A menu appears.

2 Click Check Applications. The Fix Applications page appears. 

Click the button for help on the following:

{button ,JI(`FIRSTAID.HLP',`secondary_Add_and_remove_applications')} Add or remove an application from the Fix Applications 
page

{button ,JI(`FIRSTAID.HLP',`Trim_an_application')} Trim an application



Fix Info

The Fix Info page provides a list of possible solutions for a problem or problem group. To execute a solution, select it and click 
either AutoFix or Manual Fix, whichever is appropriate. 

The Fix Info page contains the following buttons:

n Ignore in Future—If you don't want First Aid to report a particular problem or group of problems in the future, click Ignore in 
Future. Next time you run Check-Up, that problem will not appear. Ignored problems can be viewed or altered in the Problem 
Log.

n Manual Fix—Execute the suggested solution manually. When you click Manual Fix, First Aid either guides you through the 
process or provides detailed step-by-step written information. 

n AutoFix—Execute the suggested solution automatically. 

n Back—Return to the previous page.

To get to Fix Applications

n From any problem screen, click Fix Info.

{button ,AL(`Ignore a problem;Reverse an ignored problem',0,`',`')}    See Also



Videos

The Videos page provides a list of instructional videos from which to choose. The Videos page contains two buttons:

n Play—Play the selected video. You can also play a video by double-clicking it.

n Back—Return to the previous page.

To get to the Videos page

n Do one of the following:

§ Click Ask Advisor on the First Aid Desktop, then click Videos.

§ From the Help menu, click First Aid Videos.



Ignored Problems

The Ignored Problems page contains a permanent list of all ignored problems. The Ignored Problems page has two buttons:

n Remove—Select an item in the list and click Remove. Removing an item from the Ignored Problems list means that it is no 
longer ignored by Check-Up.

n Back—Return to the previous page.

{button ,JI(`FIRSTAID.HLP>second',`fa98_Ignore_problems')} Click here for help on ignoring problems. 

To get to the Ignored Problems page

n From anywhere in the program, click Options on the menu bar and click Ignored Problems



The First Aid Desktop

The First Aid Desktop is the starting point for using First Aid. The First Aid Desktop contains the following components:

n Check-Up button—To run a check-up on you entire system, click Check-Up. To customize exactly what checks are run, right-
click Check-Up. This will take you to the Settings dialog box.

n A computer system and its components—When you click any component, a menu appears. The menu contains the 
following options:

Check [component]—Runs a check on the specified component

Videos—Plays an instructional video related to that component. 

Settings—Allows you to customize Check-Up for that component.

n Universal Undo button—Displays the Universal Undo page, which lets you reverse changes made to your PC due to 
installation, changing Windows settings, or performing an action in First Aid. 

n Ask Advisor button—Displays the Ask Advisor page, which lets you access sources of information about your PC. 

To get to the First Aid Desktop

n From anywhere in the program, click Home on the navigation bar.

{button ,AL(`Check-Up Settings;Customize Check-Up;Emergency Care;Fix Applications;Show or hide Bubble Help;The 
Reference Desk;Troubleshoot a specific problem;Videos',0,`',`')}    See Also



 #Manual Fix Info

The Manual Fix Info page presents a list of possible manual solutions to a problem or problem group.

The Manual Fix Info page has the following buttons:

n Manual Fix—To actually execute a solution, select it and click Manual Fix. 

n Back—Return to the previous page.

To get to the Manual Fix Info page

n On any problem page, select a problem or problem group and click Fix Info. If AutoFix is not available, you will go 
automatically to the Manual Fix Info page. 



No Problems Found

This page appears when Check-Up has scanned your computer and found no problems. If you're having problems that Check-
Up did not detect, use the Advisor to diagnose and solve your problem. 

The page has the following buttons:

n Yes—Enter the Advisor.

n No—Return to the First Aid Desktop.

n Cancel—Return to the First Aid Desktop.



Problems Page

The Problems Page presents the problems found sorted by severity: 

n Critical Problems—Serious problems that deserve your immediate attention.

n Potential Problems—Irregularities that could turn into problems if not addressed.

n Tips & Performance Issues—Suggestions for improving the performance of your computer.

The Problems Page contains the following buttons:

n Ignore—Ignore this problem or problem detail in future checks.

n Fix Info—See a list of possible solutions for the selected problem or performance tip.

n AutoFix—Fix the selected problem(s) or performance tip(s) automatically. If the selected item or items cannot be fixed 
automatically, the Manual Fix Info page appears.

n Back—Return to the Check-Up Report.

To get to the Problems Page

n On the Check-Up Report, click View to see critical problems, potential problems, or tips and performance issues respectively. 



Problem Log

The Problem Log is a permanent list of fixed problems. First Aid automatically keeps the log up-to-date.

The Problem Log has the following buttons:

n Print—Print the Problem Log.

n Remove—To remove an item from the Problem Log, select the item and click Remove. 

n Back—Return to the previous page.

To get to the Problem Log

n From anywhere in the program, click Options on the menu bar and click Problem Log.



Recent Check-Up

The Recent Check-Up page appears when you try to run a Check-Up on all or part of your computer for a second time. This 
page is just a reminder that running a new Check-Up will erase the results of the previous Check-Up.

The Recent Check-Up page has three buttons:

n View—Go to the Check-Up Report to see the status of your previous Check-Up.

n Cancel—Go to the First Aid Desktop.

n Check-Up—Start Check-Up.



Restart Required

Sometimes you must restart your computer before a fix can take effect. If this is the case, the Restart Required page appears.

The Restart Required page has two buttons:

n Restart—Restart your computer now,

n Cancel—Continue using First Aid and restart your computer later.

Warning

Restarting your computer will erase any record of unresolved problems from the Check-Up Report. However, fixing one 
problem often fixes many, so it's a good idea to turn off your computer and run another Check-Up before trying to resolve your 
other problems.



Universal Undo

The Universal Undo page provides you with different ways to return your PC to a previous state by reversing changes made to 
your PC. 

When you install new software, change a Control Panel setting, change a document, change an Internet or network setting, or 
perform a fix in First Aid, Event Monitor (which is part of First Aid Guardian) watches over changes to your PC. Event Monitor 
keeps track of what files are added, updated, and removed, and what changes made to the Windows Registry. 

§ Undo an Installation—Use this wizard to thoroughly remove software from your PC. If you install new software and then find 
it causes problems, you can remove it quickly and thoroughly. 

§ Undo a Windows Setting Change— Use this wizard if you changed a setting in Windows Control Panel and want to return to 
a previous setting. Event Monitor tracks changes made to the following applets: Display, Keyboard, Modems, Mouse, 
Multimedia, Printers, Sounds, and System.

§ Undo a Document Change—Use this wizard to return to a previous version of a document created by the monitored 
application.

§ Undo an Internet / Network Change—Use this wizard to 

§ Undo a First Aid Fix—Use this wizard to reverse a First Aid fix. Although First Aid fixes have been tested thoroughly, a fix can 
still cause an unexpected change in your PC. For example, if your hardware is identified incorrectly by Windows, First Aid may 
change settings to match the incorrect hardware.

Note

You can undo only those changes that were made while Event Monitor was running.

To open Universal Undo

§ Click Universal Undo on the First Aid Desktop.

{button ,AL(`undo',0,`',`')}See Also



First Aid Undo page

The First Aid Undo page displays a list of all the fixes that First Aid has performed. Select the fix that you want to use.

The First Aid Undo has three buttons:

n Undo/Redo—This button displays either “Undo” or “Redo,” depending on which fix is selected. Click Undo to reverse the 
selected First Aid fix. Click Redo to reinstate a First Aid fix—a fix on which you’ve previously used Undo.

n Remove—Deletes the selected fix from the list of fixes. After you remove a fix, you can no longer Undo or Redo it.

n Back—Closes the First Aid Undo page and returns you to the previously viewed page.

To open First Aid Undo

1 Click Universal Undo on the First Aid Desktop. 

2 Click Undo A First Aid Fix.



Update page

First Aid uses Oil Change technology to update itself over the Internet. You must have an Internet connection to use this feature.

The update page has three buttons:

n Update—Connect to the McAfee server and search for the latest update to First Aid. If there are new updates available, Oil 
Change will list them and download and install them automatically. 

n History—Oil Change keeps track of the updates it downloads, installs, and uninstalls. The History feature allows you to review 
update activity.

To get to the Update page

n From anywhere in the program, Update Now on the menu bar.

{button ,AL(`Undo an update',0,`',`')}    See Also 

{button ,AL(`Undo an update;Update First Aid;View update history',0,`',`')}    See Also



First Aid Guardian

After you install First Aid, First Aid Guardian runs automatically every time you start Windows. When First Aid Guardian is active, 
a blue cross appears in your system tray in the lower-right corner of your screen.

 First Aid Guardian cross.
First Aid Guardian is made up of a series of monitors that keep a constant lookout for computer problems. If a monitor senses that 
something's wrong, it issues a warning and suggests a course of action. 
First Aid Guardian consists of the following monitors:

{button ,JI(`FIRSTAID.HLP>second',`fa98_Use_CPR')} CPR 

{button ,JI(`FIRSTAID.HLP>second',`fa98_Use_Crash_Protector')} Crash Protector 

{button ,JI(`FIRSTAID.HLP>second',`fa98_Use_Disk_Space_Monitor')} Disk Space Monitor 

{button ,JI(`firstaid.hlp>second',`Use_Event_Monitor')} Event Monitor 

{button ,JI(`FIRSTAID.HLP>second',`fa98_Use_Memory_Monitor')} Memory Monitor 

{button ,JI(`firstaid.HLP>second',`Clean_up_unnecessary_files')}Quick Clean Monitor

{button ,JI(`FIRSTAID.HLP>second',`fa98_Use_Early_Warning')} S.M.A.R.T. Disk Monitor 

{button ,AL(`Enable or disable Windows Guardian;Enable Windows Guardian Monitors;Set Windows Guardian Properties',0,`',`')} 
See Also



World Wide Web

Because First Aid automatically functions as a browser, you can move effortlessly from the program itself to the World Wide Web 
and then back again. 

You can perform the following actions while browsing the Web:

{button ,PI(`FIRSTAID.HLP',`secondary_Return_to_the_Main_Desktop')} Return to First Aid's First Aid Desktop

{button ,PI(`FIRSTAID.HLP',`secondary_Go_back_to_the_last_page')} Go back to the last page

{button ,PI(`FIRSTAID.HLP',`secondary_Go_forward_to_the_next_page')} Go forward to the next page

{button ,PI(`FIRSTAID.HLP',`secondary_Stop_the_current_transfer')} Stop the current transfer



Ask Advisor

The Ask Advisor page gives you access to sources of information about your PC that let your troubleshoot problems and learn 
more about the PC.

§ Knowledge Base—When you are having a problem, you can ask questions and First Aid will search its knowledge base for 
an answer.

§ Glossary—If you encounter a term that you don't understand, you can consult the First Aid Glossary for a definition.

§ Technical Support Yellow Pages—If you need to contact a hardware or software manufacturer, you can get the address, 
telephone number, and if the business has them, e-mail and Web addresses.

§ Videos—First Aid provides you with a library of instructional videos on a wide range of computer-related tasks, such as 
plugging your modem into a phone line and cleaning your mouse.

§ System Info—First Aid opens the Discover, a utility that lets you view a wealth of system information, as well as perform 
benchmark tests.

§ Unlike other system information tools, Discover doesn't simply display information that it obtained from Windows. Discover 
actually tests and measures the hardware and software in your system. 

To get to Ask Advisor

§ Click Ask Advisor on the First Aid Desktop.

{button ,AL(`advisor',0,`',`')}    See Also



Frequently Asked Questions knowledge base

There are times when First Aid must interact with you in order to provide a solution to your problem. Use the Knowledge Base to 
explore a wide array of common computer-related questions asked by people trying to troubleshoot PC problems. Just click the 
general category that most directly relates to your question. Continue clicking the appropriate topic title until you find the answer 
to your question. With your help, the First Aid narrows down the possible causes to your problem. 

To get to the Knowledge Base

§ If Check-Up does not detect your problem, you are automatically given the option of entering the Advisor Knowledge Base.

§ To access the Knowledge Base directly, click Ask Advisor on the First Aid Desktop, then click Knowledge Base.

To exit the Knowledge Base

§ You can exit the Knowledge Base at any time by clicking Finished or Home.



Advisor solutions

Depending on the solution to your problem, the solutions page may contain any combination of the following:

n Step-by-step instructions on how to fix your problem.

n AutoFix button
Automatically fix your problem.

n Manual Fix button
Fix the problem yourself with First Aid's assistance.

n How Do I? button
Play an instructional video related to your problem.

To exit the solutions page.

You can exit the solutions page at any time by clicking Finished or Home.



FAQ solutions

The solutions page in Frequently Asked Questions provides step-by-step instructions on how to fix your problem.

To exit the solutions page.

You can exit the solutions page at any time by clicking Finished or Home.



Contacting Technical Support

This page contains the telephone number and email address of First Aid Technical Support. However, the best and most up-to-
date source for information about First Aid is the McAfee Web site Support page at http://www.mcafee.com/support/. 

Please keep in mind that technical support addresses only those problems specifically related to First Aid. If you are having a 
general computer problem that Check-Up and Advisor could not solve, use the Technical Support Yellow Pages to find contact 
information for the vendor of the hardware or software product your are having a problem with.

Refer to the quick start card that came with your software for our technical support policy.



About First Aid

This page contains the version and copyright information for First Aid.



Tell us about First Aid

This page contains a form that you can use to send feedback about First Aid. 

If you decide not to send the email, just click Back to return to the previous page.

The Tell us about First Aid page contains the following button:

n Submit—Sends the email to McAfee. 



Register First Aid

Click Yes to register your copy of First Aid. 

Try to take the time to register your copy. If you register, you will be notified of product updates and any special offers in the 
future. If you choose not register your copy of First Aid now, you can do so at any time.

{button ,JI(`FIRSTAID.HLP>second',`fa98_Register_First_Aid')} Click here for help on registering First Aid.



First Aid VirusScan

First Aid is checking your entire system for viruses. If a virus is found, you will be alerted. To cancel VirusScan at any time, click 
Cancel. When VirusScan is finished scanning, exit the page by clicking Finished. 



First Aid QuickClean

The QuickClean wizard gets rid of unnecessary files, such as Internet junk files, empties the Recycle Bin, and removes 
references in the Registry to applications that are no longer installed on your computer.

QuickClean is designed to be set up with defaults so safe that it can run automatically on a schedule. But you can also run it 
manually at any time by clicking Clean Up Unnecesary Files from the Tools menu.

QuickClean guides you through the following steps:

§ Step 1: Select cleaners. 

§ Step 2: Analyze system. 

§ Step 3: View items to be removed. 

§ Step 4: Delete unneeded items. 

§ Step 5: Review summary information. 

{button ,KL(`Scheduling First Aid events',0,`',`')} Click here for information on scheduling Quick Clean.



Return to the First Aid Desktop

You can return to the First Aid Desktop at any time by clicking Home in the First Aid navigation bar.

 Home button



Go back to the last page

First Aid keeps a list of all the pages you have viewed. You can use the navigation bar to move back and forth in this list. To 
return to the previous page, click Back. 

 Back arrow



Go forward to the next page

First Aid keeps a list of all the pages you have viewed. You can use the navigation bar to move back and forth in this list. To view 
the next page in the history list, click Next.

 Next arrow

Note

Next only takes you to pages you have already visited. In other words, it reverses the Back button. You cannot use Next until 
you use Back. 



Stop the current transfer

As in any Web browser, the Stop button in First Aid interrupts the transfer of the current Web page.

 Stop button
Click Stop in the First Aid navigation bar only while browsing the World Wide Web. 



Oil Change

Oil Change is McAfee's revolutionary Internet service that keeps your software up to date by logging into a central database of 
patches and updates and automatically downloading them to your PC.

First Aid uses Oil Change technology to update its knowledge base. The full version of Oil Change is a separate product from 
First Aid. You can find out more about Oil Change on the World Wide Web at http://www.mcafee.com.



The Tools menu

The Tools menu contains the following items:

{button ,JI(`firstaid.HLP>second',`fa98_Create_a_backup')} Backup Important Files 

{button ,JI(`firstaid.HLP>second',`fa98_Restore_a_backup')} Restore Backup Archive 

{button ,JI(`firstaid.HLP>second',`fa98_Create_an_emergency_disk')}Emergency Disk 

{button ,JI(`firstaid.HLP>second',`fa98_Run_Disk_Defragmenter')} Defragment Hard Drive 

{button ,JI(`firstaid.HLP>second',`fa98_Run_ScanDisk')} Check Hard Disk for Errors 

{button ,JI(`firstaid.HLP>second',`Clean_up_unnecessary_files')} Clean Up Unnecessary Files 

{button ,JI(`firstaid.HLP>second',`Run_Year_2000_Checker')} Check for Year 2000 Compliance



The Options menu

The Options menu contains the following items:

{button ,JI(`FIRSTAID.HLP>second',`secondary_Show_or_hide_Bubble_Help')} Show/Hide Bubble Help

{button ,JI(`FIRSTAID.HLP>second',`screens_Problem_Log')} Problem Log

{button ,JI(`FIRSTAID.HLP>second',`screens_Ignored_Problems')} Ignored Problems

{button ,JI(`FIRSTAID.HLP>second',`fa98_Customize_First_Aid')} Settings>First Aid

{button ,JI(`FIRSTAID.HLP>second',`screens_Check_Up_Settings')} Settings>Check-Up

{button ,JI(`firstaid.HLP>second',`screens_Register_First_Aid')} Register First Aid 2000 

{button ,JI(`FIRSTAID.HLP',`secondary_The_Help_menu')}    See Also



The Help menu

{button ,JI(`FIRSTAID.HLP>second',`fa98_Get_Help_while_you_work')} Help For This Page

{button ,JI(`FIRSTAID.HLP>second',`fa98_Get_Help_while_you_work')} First Aid Help Topics

{button ,JI(`FIRSTAID.HLP>second',`fa98_Videos')} Reference>First Aid Videos

{button ,JI(`FIRSTAID.HLP>second',`fa98_Glossary_of_PC_Terms')} Reference>Glossary of PC Terms

{button ,JI(`FIRSTAID.HLP>second',`fa98_Tech_Support_Directory')} Reference>Technical Support Yellow Pages

{button ,JI(`FIRSTAID.HLP>second',`screens_Advisor')} Reference>Frequently Asked Questions

{button ,JI(`FIRSTAID.HLP>second',`secondary_CyberMedia_Home_Page')} McAfee on the Web>McAfee Home Page

{button ,JI(`FIRSTAID.HLP>second',`secondary_CyberMedia_Support')} McAfee on the Web>McAfee Support

{button ,JI(`FIRSTAID.HLP>second',`screens_Tell_us_about_First_Aid')} Send Us Feedback

{button ,JI(`FIRSTAID.HLP>second',`screens_Contacting_Tech_Support')} Contacting Technical Support

{button ,JI(`FIRSTAID.HLP>second',`screens_About_First_Aid')} About First Aid



First Aid Tutorial

The First Aid Tutorial is the introductory video you saw when you ran First Aid for the first time. This video provides an overview 
of the product and points out many of the First Aid's most important features.

To play the First Aid Tutorial

n Click Help on the menu bar and click First Aid Tutorial.



The navigation bar

At the top of the First Aid Desktop is the navigation bar appears. It allows First Aid to function like a Web browser. Like all Web 
browsers, the First Aid navigation bar contains the following buttons:

 Back

 Home

 Next
First Aid keeps a record of all the pages you have viewed and stores them in a history list. With the navigation bar, you can move 
up and down this list. 

The navigation bar includes the following menus:

§ Tools—From this menu you can run additional First Aid components and Windows utility programs.

§ Options—From this menu you can change settings, view the Problem Log, and register First Aid.

§ Help—From this menu you can find out more about how First Aid and your PC work. In addition to Windows Help files, you 
can also open the same reference tools available from the Ask Advisor page. 

Don't be afraid to explore. Because First Aid remembers where you've been, you can always get back to where to you started. 

{button ,AL(`menu',0,`',`')}    See Also



Run a component-specific Check-Up

1 Click the component you want to check.

2 A menu appears. Click Check-Up. 
First Aid checks only that component. When Check-Up is finished, the results are displayed in the Check-Up Report.



ScanDisk Standard scan

ScanDisk's Standard scan detects and repairs a number of types of problems with your disk's file system, including the following:

n FAT errors

n Lost clusters and cross-linked files

n Directory tree errors

n Bad tracks

Click Advanced to customize the Standard scan.

For a more complete scan, choose the Thorough option.



ScanDisk Thorough scan

ScanDisk's Thorough scan performs a surface scan analysis of your disk in addition to the standard detection and repair. A 
Thorough scan takes considerably longer than a Standard scan.

If you choose Thorough mode in the ScanDisk dialog box, you can set options by clicking Options.



Surface Scan Options

The Surface Scan Options dialog box provides the following options:

n Areas of the disk to scan.
This group of options specifies which area of the disk to scan for defects: system area, data area, or both.

n Do not perform write-testing.
If you check this box, ScanDisk reads but does not rewrite the data. If you clear the check box, ScanDisk writes each sector of 
the disk to check its condition.

n Do not repair bad sectors in hidden system files.
Check this box if you do not want ScanDisk to relocate the sectors of hidden and system files to new locations, even if these 
sectors are damaged. It is recommended that you leave this box unchecked.



Run ScanDisk by itself

1 From the Tools menu, click Check Hard Drive For Errors. The ScanDisk dialog box appears. 

2 Choose the drive(s) you want to scan.

3 Select Standard mode or Thorough mode. If you choose Thorough mode in the ScanDisk dialog box, you can set options by 
clicking Options.

4 If you want ScanDisk to automatically fix all errors, select the Automatically fix errors check box. If this box is cleared, 
ScanDisk will prompt you each time before fixing an error.

5 If you want to customize ScanDisk settings, click Advanced. This takes you to the ScanDisk Advanced Options dialog box. 
When you are finished, click OK to return to the ScanDisk dialog box.

6 Click Start to run ScanDisk.

Note

If McAfee Nuts & Bolts software is installed, First Aid uses Disk Minder—the more advanced disk repair utility in Nuts & Bolts
—to diagnose and fix hard drive problems. Please refer to the documentation that came with Nuts & Bolts for more information 
on Disk Minder.



Set Crash Protector Properties

1      Right-click   the blue cross  in the lower-right corner of your screen, then click First Aid Properties.

2 Click the word Crash Protector.

3 Change Crash Protector settings and click OK. To disable Crash Protector, clear its check box in the Monitors list.

Tip

If the blue cross does not appear on your screen, First Aid Guardian is disabled. 
{button ,JI(`FIRSTAID.HLP>second',`secondary_Enable_or_disable_Windows_Guardian')} Click here for help on turning on 
First Aid Guardian.



View Crash Protector Statistics

1      Right-click   the blue cross  in the lower-right corner of your screen, then click First Aid Properties.

2 Click the word Crash Protector.

3 Click Statistics.



Test Crash Protector

1 Save your data and close down all open applications.

2      Right-click   the blue cross  in the lower-right corner of your screen, then click First Aid Properties.

3 Click the word Crash Protector.

4 Click the 16-bit or 32-bit Test button. First Aid generates a crash and a dialog box appears.
Carefully follow the instructions in the dialog box to run the test. When the test in finished, you may be asked to restart your 
computer. Make sure you save your data and close all open applications before running the test.

Tip

If the blue cross does not appear on your screen, First Aid Guardian is disabled. 
{button ,JI(`FIRSTAID.HLP>second',`secondary_Enable_or_disable_Windows_Guardian')} Click here for help on turning on 
First Aid Guardian.



Set CPR properties

1      Right-click   the blue cross  in the lower-right corner of your screen, then click First Aid Properties.

2 Click the word CPR.

3 You can reactivate an inactive application, view CPR statistics, or test 16-bit and 32-bit application freezes. To disable CPR, 
clear its check box in the Monitors list.

Tip

If the blue cross does not appear on your screen, First Aid Guardian is disabled. 
{button ,JI(`FIRSTAID.HLP>second',`secondary_Enable_or_disable_Windows_Guardian')} Click here for help on turning on 
First Aid Guardian.



View CPR Statistics

1      Right-click   the blue cross  in the lower-right corner of your screen, then click First Aid Properties.

2 Click the word CPR.

3 Click Statistics.



Test CPR

1      Right-click   the blue cross  in the lower-right corner of your screen, then click First Aid Properties.

2 Click the word CPR.

3 Click the 16-bit or 32-bit CPR test. The test locks up your computer.

4 Select the non-responsive application from the list and click Reactivate. 

5 If a 32-bit application is frozen, CPR selects it automatically. 

6 If the 16-bit application is frozen, you may have to select a different application in the list and try again until you unfreeze the 
application that is frozen.

7 Follow the messages on the screen to continue.

WARNING: Do not click the Close Application button until you have saved your work, otherwise you will lose your data.

Tip

If the blue cross does not appear on your screen, First Aid Guardian is disabled. 
{button ,JI(`FIRSTAID.HLP>second',`secondary_Enable_or_disable_Windows_Guardian')} Click here for help on turning on 
First Aid Guardian.



Set Event Monitor properties

1      Right-click   the blue cross  in the lower-right corner of your screen, then click First Aid Properties.

2 Click the word Event Monitor, then click Settings.



Set S.M.A.R.T. Disk Monitor properties

1      Right-click   the blue cross  in the lower-right corner of your screen, then click First Aid Properties.

2 You can only turn on or off the S.M.A.R.T. Disk Monitor. To disable S.M.A.R.T. Disk Monitor, clear its check box in the Monitors 
list.

Tip

If the blue cross does not appear on your screen, First Aid Guardian is disabled. 
{button ,JI(`FIRSTAID.HLP>second',`secondary_Enable_or_disable_Windows_Guardian')} Click here for help on turning on 
First Aid Guardian.



Set Memory Monitor properties

1      Right-click   the blue cross  in the lower-right corner of your screen, then click First Aid Properties.

2 Click the word Memory Monitor.

3 Select or change its alert settings. To disable Memory Monitor, clear its check box in the Monitors list.

Tip

If the blue cross does not appear on your screen, First Aid Guardian is disabled. 
{button ,JI(`FIRSTAID.HLP>second',`secondary_Enable_or_disable_Windows_Guardian')} Click here for help on turning on 
First Aid Guardian.



Set Quick Clean properties

1      Right-click   the blue cross  in the lower-right corner of your screen, then click First Aid Properties.

2 Click the word Quick Clean.

3 Select the cleaners to use. Click the name of a cleaner to read its description. To disable Quick Clean, clear its check box in 
the Monitors list.

Tip

If the blue cross does not appear on your screen, First Aid Guardian is disabled. 
{button ,JI(`FIRSTAID.HLP>second',`secondary_Enable_or_disable_Windows_Guardian')} Click here for help on turning on 
First Aid Guardian.



Set Disk Space Monitor Properties

1      Right-click   the blue cross  in the lower-right corner of your screen, then click First Aid Properties.

2 Click the word Disk Space Monitor.

3 Select the drives to monitor set a disk space level for each alert. To disable Disk Space Monitor, clear its check box in the 
Monitors list.

Tip

If the blue cross does not appear on your screen, First Aid Guardian is disabled. 
{button ,JI(`FIRSTAID.HLP>second',`secondary_Enable_or_disable_Windows_Guardian')} Click here for help on turning on 
First Aid Guardian.



Respond to Disk Space Monitor warning

§ Do one of the following:

§ To remove non-essential files, click Run QuickClean. The QuickClean wizard walks you through removing files that are 
taking up disk space, but can be removed safely without losing data or affecting the operation of your computer. 

§ To change the alert criteria for Disk Monitor alert messages, click Properties. 

§ To close the dialog box without taking action, click Exit. 



Enable or disable First Aid Guardian

If you're not sure whether First Aid Guardian is enabled (active) or not, check the status area in the Windows taskbar—normally 

in the lower-right corner of your screen. If you see a blue cross  First Aid Guardian is enabled.

To enable or disable First Aid Guardian permanently.

1      Right-click   the blue cross  in the lower-right corner of your screen.

2 Click First Aid Properties. The First Aid Guardian Properties dialog box appears.

3 On the First Aid Guardian tab, select or clear the First Aid Guardian check box.

4 Click OK.

The new settings stay in effect until you change them again.

To enable or disable First Aid Guardian temporarily

1 Click Start on the taskbar.

2 Point to Programs, point to First Aid, and click First Aid Guardian.

The change is only temporary. First Aid Guardian will reset itself when you restart your computer.

Warning

If you clear the First Aid Guardian check box, you are turning off CPR, Crash Protector, Disk Space Monitor, Event Monitor, 
Memory Monitor, Quick Clean, and S.M.A.R.T. Disk Monitor.



Enable First Aid Guardian Monitors

1      Right-click   the blue cross icon  in the lower-right corner of your screen.

2 Click First Aid Properties. The Properties dialog box appears.

3 In the First Aid Guardian tab, select the check box next to the First Aid Guardian monitor that you want to enable.

4 Click the monitor name to see the properties you can change for that monitor. 



Set First Aid Guardian Properties

1      Right-click   the blue cross in the lower-right corner of your screen.

2 Click First Aid Properties. The Properties dialog box appears.

3 Click the monitor name to see the properties you can change for that monitor. The monitor must be selected before you can 
change its settings. If necessary, select the check box next to the First Aid Guardian monitor to enable it.



View the checks for a computer component

In the Settings dialog box, click the + to the left of the check category to display the list of checks belonging to that category.

 For example, to view the list of network-related checks, click the computer box on the First Aid Desktop and click Settings. Click 
the + to the left of Network to display the list of network-related checks.

Note

The settings for individual component checks are separate from general Check-Up settings.

{button ,AL(`Customize Check-Up',0,`',`')}    See Also



Add/Remove a check in Check-Up

To add a check to Check-Up

In the Settings dialog box, select the check box for that check.

To remove a check from Check-Up

In the Settings dialog box, clear the check box for that check or group of checks..

Note

The settings for individual component checks are separate from general Check-Up settings.

{button ,AL(`Customize Check-Up',0,`',`')}    See Also



Set Check-Up to be as thorough as possible

From the Settings dialog box, click Select All.



Restore the default Check-Up configuration

From the Settings dialog box, click Defaults. This will restore the original configuration.



Save a Check-Up configuration

When you've finished configuring Check-Up in the Settings dialog box, click OK. First Aid will remember your new settings. To 
exit without saving the settings, click the Exit.



Ignore a problem

To ignore a problem

On the Critical Problems, Potential Problems, or Tips & Performance Issues pages, select the problem you want to ignore and 
click Ignore.

{button ,AL(`Reverse an ignored problem',0,`',`')}    See Also



Reverse an ignored problem

To reverse an ignored problem

1 Click Options on the menu bar and click Ignored Problems. The Ignored Problems page appears.

2 To reverse an ignored problem, select it from the list and click Remove. The problem will not longer be ignored by Check-Up.

3 To exit, click Finished. 

{button ,AL(`Ignore a problem',0,`',`')}    See Also



Play a video

To play a video

1 Do one of the following:

§ From the Help menu, click First Aid Videos.

§ From the First Aid Desktop, click Ask Advisor, then click Videos.

2 Click the name of the video you want to view, then click Play. You can also play a video simply by double-clicking it.



Show or hide Bubble Help

Bubble Help are the white text balloons that appear when you pass the mouse pointer over any clickable item on the First Aid 
screen.

To show or hide Bubble Help

n Click Options on the menu bar and click Show/Hide Bubble Help



Add and remove applications

To add an application to the applications list

1 On the Fix Applications page, right-click anywhere in the workspace. A shortcut menu appears.

2 Click Add.

3 Locate the program file (a file with the extension .EXE) for the application that you want to add, and select it. Your selection 
must appear in the File name box.

4 Click Open. The application is added to the Applications list.

To remove an application from the applications list

1 On the Fix Applications page, right-click the application you want to remove. A shortcut menu appears.

2 Click Remove.



Check an application

To check an application

1 Click the Generic Software box in the lower-right corner of the First Aid Desktop. A menu appears.

2 Click Check Applications. The Fix Applications page appears.

3 To begin checking an application, do one of the following:

§ Double-click an icon. 

§ Click an icon and then click Check. 

{button ,AL(`Add and remove applications',0,`',`')}    See Also



Undo an update

To undo an update to First Aid, you must use Oil Change .

To undo an update

Click Start on the taskbar, point to Programs, point to First Aid Oil Change, and click Oil Change.

In the Oil Change application, click Undo. The Undo dialog box appears.

Select the update you want to undo and click Undo.

Note

You can also delete an update from the list by clicking Delete in the Undo dialog box.

{button ,AL(`Update First Aid;Update page;View update history',0,`',`')}    See Also



View update history

To view your update history

1 From anywhere in First Aid, click Update Now on the menu bar. The Update page appears.

2 Click History.

{button ,AL(`Undo an update;Update First Aid;Update page',0,`',`')}    See Also



McAfee Home Page

The McAfee home page http://www.mcafee.com contains information on McAfee and its products, such as UnInstaller, Guard 
Dog, and Oil Change.

Note

You must have an Internet connection to use this feature.



Contacting McAfee

Contacting McAfee takes you to the McAfee home page http://www.mcafee.com on the World Wide Web. This page contains 
information on McAfee and its products, such as VirusScan, Uninstaller, Guard Dog, and Oil Change.

Note

You must have an Internet connection to use this feature.



McAfee Support

McAfee Support takes you to the McAfee support page http://www. mcafee.com/support on the World Wide Web. This page 
contains links to McAfee Online support forums, FAQs, and more. 

Note

You must have an Internet connection to use this feature.



Scan the Applications list

On the Fix Applications page, click Scan.

When you click the monitor on the First Aid Desktop and click Fix Applications, First Aid scans your hard drive and lists the 
applications that it finds. Use the Scan button to rescan for applications after you've done something that would affect this list, 
such as adding or removing an application.



Print a list of all problems found

To print a list of all problems found

n From the Check-Up Report, click Print.

Note

The printed problem report includes all critical problems, potential problems, and tips & performance issues found by the latest 
session of Check-Up. If you restart your computer or run Check-Up again, this list will change.

{button ,AL(`Print a list of all problems fixed;Print system information',0,`',`')}    See Also



Print a list of all problems fixed

To print a list of all problems fixed.

1 Click Options on the menu bar and click Problem Log. The Problem Log page appears.

2 Click Print.

Note

The Problem Log contains a history of all the problems First Aid has fixed automatically over time.

{button ,AL(`Print a list of all problems found;Print system information',0,`',`')}    See Also



Undo an installation

If you install new software and then find it causes problems, you can remove it quickly and thoroughly.

To undo an installation

1 From the First Aid Desktop, click Universal Undo. The Universal Undo page appears.

2 Click Undo An Installation. 

3 Select an installation to undo, then do one of the following:

§ If you don’t see the installation you want, click Browse to try to locate the event archive.

§ If there is an installation in the list that you no longer want to see, click Delete.

§ If you want to change the name of an installation, click Rename and type the new name.

4 Click Next to analyze your PC and determine which components to remove and restore. 

5 If you want to view installation details about or select individual items to restore, click Details. The different colored icons 
indicate the safety of reversing each action: a green triangle means safe, a yellow square means probably not safe, and a red 
circle means unsafe. When you are finished, click OK.

6 Click Next to complete the installation undo. When Installation Undo is finished, a summary screen displays the results of the 
undo.

7 Click Finish to close the wizard. You may be asked to restart you computer to activate the changes.



Undo a Windows settings change

Making incorrect changes to your Windows Control Panel settings can cause your PC to function poorly. Use Undo a Windows 
Settings Change to recover your previous Control Panel settings.

To undo a Windows settings change

1 From the First Aid Desktop, click Universal Undo. The Universal Undo page appears.

2 Click Undo A Windows Settings Change. 

3 Select a archive to undo, then do one of the following:

§ If you don’t see the archive you want, click Browse to try to locate the event archive.

§ If there is an archive in the list that you no longer want to see, click Delete.

§ If you want to change the name of an archive, click Rename and type the new name.

4 Click Next to analyze your PC and determine the actions to perform. 

5 If you want to view details or select individual actions to perform, click Details. The different colored icons indicate the safety of 
reversing each action: a green triangle means safe, a yellow square means probably not safe, and a red circle means unsafe. 
When you are finished, click OK.

6 Click Next to complete the undo. When the wizard is finished, a summary screen displays the results of the undo.

7 Click Finish to close the wizard. You may be asked to restart you computer to activate the changes.



Undo a Document Change

Use this feature to return to a previous version of a document created by a monitored application. 

To undo a document change

1 From the First Aid Desktop, click Universal Undo. The Universal Undo page appears.

2 Click Undo A Document Change. 

3 Select a archive to undo, then do one of the following:

§ If you don’t see the archive you want, click Browse to try to locate the event archive.

§ If there is an archive in the list that you no longer want to see, click Delete.

§ If you want to change the name of an archive, click Rename and type the new name.

4 Click Next to analyze your PC and determine the actions to perform. 

5 If you want to view details or select individual actions to perform, click Details. The different colored icons indicate the safety of 
reversing each action: a green triangle means safe, a yellow square means probably not safe, and a red circle means unsafe. 
When you are finished, click OK.

6 Click Next to complete the undo. When the wizard is finished, a summary screen displays the results of the undo.

7 Click Finish to close the wizard. 



Undo an Internet / Network change

If you make changes to your Internet or network settings you may find that you are unable to connect to the Internet, or that your 
connection has become unreliable. Use this feature to restore your connectivity settings to their previous state. If you change 
your mind, you can reverse the last undo at a later date.

To undo an Internet / Network settings change

1 From the First Aid Desktop, click Universal Undo. The Universal Undo page appears.

2 Click Undo An Internet / Network Change. 

3 Click Next. The snapshots appear in chronological order.

4 Select a snapshot to undo.

5 Click Next. (If your settings haven’t changed since this snapshot was created, First Aid displays, “No Change.” Click Back to 
select a different snapshot.) First Aid asks you to confirm your connectivity problems. 

6 Select the appropriate answer. You may be presented with other items to select. 

7 Click Next. First Aid displays a summary of the actions it will perform.

8 Click Finish to apply the changes and close the wizard. You may be asked to restart you computer to activate the changes.

To reverse the last Internet / Network settings undo

1 From the First Aid Desktop, click Universal Undo. The Undo page appears.

2 Click Undo An Internet / Network Change. 

3 Click Next. 

4 Click Restore.

5 Click Finish. You may be asked to restart you computer to activate the changes.



Undo a First Aid fix

Although First Aid fixes have been tested thoroughly, a fix can still cause an unexpected change in your PC. You can reverse a 
First Aid fix to see if it solves the problem. If you later decide that the fix was fine, you can use Redo to reinstate the fix.

To undo a First Aid fix 

1 From the First Aid Desktop, click Universal Undo. The Universal Undo page appears.

2 Click Undo A First Aid Fix. First Aid displays a list of fixes it has performed.

3 Click on the fix that you want to undo.

4 Click Undo. First Aid confirms that the change was reversed.

To redo a First Aid fix 

1 From the First Aid Desktop, click Universal Undo. The Undo page appears.

2 Click Undo A First Aid Fix. First Aid displays a list of fixes it has performed.

5 Click on the fix that you want to redo.

3 Click Redo. First Aid confirms that the change was reversed.




